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This chapter includes: 
• Electrical Safety ................................................................................................................................................................ 10 
• Operational Safety .......................................................................................................................................................... 11 
• Maintenance Safety ....................................................................................................................................................... 13 
• Printer Symbols ................................................................................................................................................................. 14 

Your printer and the recommended supplies have been designed and tested to meet strict safety 
requirements. Attention to the following information ensures the continued safe operation of your 
Xerox® printer. 
 
 

 1 Safety 



Safety 

 

10 Phaser 7100 Color Printer 
 User Guide 
 

Electrical Safety 

General Guidelines 
 

 WARNINGS:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or 
shorting out a part could result in fire or electrical shock. 

• Do not remove the covers or guards that are fastened with screws unless you are 
installing optional equipment and are instructed to do so. Turn off the printer when 
performing these installations. Disconnect the power cord when removing covers and 
guards for installing optional equipment. Except for user-installable options, there are 
no parts that you can maintain or service behind these covers. 

 

The following are hazards to your safety: 
• The power cord is damaged or frayed. 
• Liquid is spilled into the printer. 
• The printer is exposed to water. 
• The printer emits smoke, or the surface is unusually hot. 
• The printer emits unusual noise or odors. 
• The printer causes a circuit breaker, fuse, or other safety device to activate. 

If any of these conditions occur, do the following: 
1. Turn off the printer immediately. 
2. Disconnect the power cord from the electrical outlet. 
3. Call an authorized service representative. 
 

Laser Safety 

This printer complies with laser product performance standards set by governmental, national, and 
international agencies and is certified as a Class 1 Laser Product. The printer does not emit hazardous 
light because the beam is totally enclosed during all modes of customer operation and maintenance. 
 

 WARNING: Use of controls, adjustments, or performance of procedures other than those specified in 
this manual can result in hazardous radiation exposure. 
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Operational Safety 

Your printer and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards. 

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your 
printer. 
 

Ozone Release 

This printer produces ozone during normal operation. The amount of ozone produced is dependent on 
copy volume. Ozone is heavier than air and is not produced in amounts large enough to harm anyone. 
Install the printer in a well-ventilated room. 

For more information in the United States and Canada, go to www.xerox.com/environment. In other 
markets, please contact your local Xerox representative or go to www.xerox.com/environment_europe. 
 

Printer Location 
• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight 

of the printer. To find the weight for your printer configuration, see Physical Specifications on page 
122. 

• Do not block or cover the slots or openings on the printer. These openings are provided for 
ventilation and to prevent overheating of the printer. 

• Place the printer in an area where there is adequate space for operation and servicing. 
• Place the printer in a dust-free area. 
• Do not store or operate the printer in an extremely hot, cold, or humid environment. 
• Do not place the printer near a heat source. 
• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components. 
• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning 

system. 
• Do not place the printer in locations susceptible to vibrations. 
• For optimum performance, use the printer at elevations recommended in Elevation on page 125. 
 

Operational Guidelines 
• Do not remove any paper trays while the printer is printing. 
• Do not open the doors when the printer is printing. 
• Do not move the printer when it is printing. 
• Keep hands, hair, neckties, and so on, away from the exit and feed rollers. 
• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove 

the protective covers. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=environmentna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=environmenteu&Language=English�
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Power Cord 
• Use the power cord supplied with your printer. 
• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 

cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check 
the outlet. 

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal. 

 

 WARNING: Avoid the potential of electrical shock by ensuring that the printer is grounded properly. 
Electrical products can be hazardous if misused. 

 

• Only use an extension cord or power strip designed to handle the electrical current capacity of the 
printer. 

• Verify that the printer is plugged into an outlet that is providing the correct voltage and power. 
Review the electrical specification of the printer with an electrician if necessary. 

• Do not place the printer in an area where people can step on the power cord. 
• Do not place objects on the power cord. 
• Replace the power cord if it becomes frayed or worn. 
• Do not unplug or plug the power cord while the printer is turned on. 
• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord. 
• The electrical outlet must be near the printer and must be easily accessible. 

The power cord is attached to the printer as a plug-in device on the back of the printer. If it is necessary 
to disconnect all electrical power from the printer, disconnect the power cord from the electrical outlet. 
 

Printer Supplies 
• Use the supplies designed for your printer. The use of unsuitable materials can cause poor 

performance and a possible safety hazard. 
• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies. 
• Store all consumables in accordance with the instructions given on the package or container. 
• Keep all consumables away from the reach of children. 
• Never throw toner, print/drum cartridges, or toner containers into an open flame. 
• When handling cartridges, for example toner and such, avoid skin or eye contact. Eye contact can 

cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can increase 
the risk of skin or eye contact. 

 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 
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Maintenance Safety 

• Do not attempt any maintenance procedure that is not specifically described in the documentation 
supplied with your printer. 

• Do not use aerosol cleaners. Clean with a dry lint-free cloth only. 
• Do not burn any consumables or routine maintenance items. For information on Xerox® supplies 

recycling programs, go to www.xerox.com/gwa. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=recyclesupplies&Language=English%20%20�
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Printer Symbols 

Symbol Description 

 

Warning: 
Indicates a hazard which, if not avoided, could result in death or serious injury. 

 

Hot surface on or in the printer. Use caution to avoid personal injury. 

 

Caution: 
Indicates a mandatory action to take in order to avoid damage to the property. 

 

Do not burn the item. 

 

Do not expose the imaging unit to light for more than 10 minutes. 

 

Do not expose the imaging unit to direct sunlight. 

 

Do not touch the part or area of the printer. 

 

 

Warning: 
Wait for the printer to cool for the specified time before touching that specific area of the 
printer. 

 

 

Warning: 
Cover is not self-supporting. Use care to support with your hand or the built-in support. 
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This item can be recycled. For details, see Recycling and Disposal on page 135. 

 

Do not try to close the Toner Cover while Cover C is open. 

 

Caution: 
To prevent a printer malfunction or internal hard drive damage, ensure that the HDD control 
panel indicator is off before turning off the power switch. 
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This chapter includes: 
• Parts of the Printer ........................................................................................................................................................... 18 
• Printer Reports ................................................................................................................................................................... 22 
• Energy Saver Mode ......................................................................................................................................................... 23 
• Administration Features ................................................................................................................................................ 24 
• More Information ............................................................................................................................................................ 26 
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Parts of the Printer 

This section includes: 
• Front View ........................................................................................................................................................................... 18 
• Rear View ............................................................................................................................................................................ 19 
• Internal Components Under Covers A and C ........................................................................................................ 19 
• Internal Components Under Cover B and Waste Toner Container Cover .................................................. 20 
• Control Panel ..................................................................................................................................................................... 20 
 
 

Front View 

 
1. Power Switch 
2. Cover A Release Latch 
3. Toner Cover 
4. Output Tray 
5. Control Panel 

6. Cover A 
7. Cover B Release Button 
8. Bypass Tray 
9. Tray 1 
10. Optional 550-Sheet Feeders (Trays 2–4) 

 

Note: A 250-sheet adjustable Tray 1 and a 150-sheet Bypass Tray are standard. Up to three 
optional 550-Sheet Feeders provides a maximum of five trays, for a maximum 2050-sheet input 
capacity. 
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Rear View 

 
1. Ethernet Connection 
2. USB Connection 

3. Power Connector 
4. Rear Cover 

 
 

Internal Components Under Covers A and C 

 
 

1. Cover A Release Latch 
2. Cover A 
3. Transfer Roller 
4. Toner Cover Handle 
5. Cover C 

6. Cover C Release Lever 
7. Toner Cartridges 
8. Transfer Belt 
9. Cleaning Tool 
10. Imaging Units 

 

Note: The Transfer Belt is not customer replaceable. 
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Internal Components Under Cover B and Waste Toner Container Cover 

 
 

1. Cover B Release Button 
2. Cover B 
3. Duplex Unit 

4. Fuser 
5. Waste Toner Container Cover 
6. Waste Cartridge/Waste Toner Container 
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Control Panel 

The control panel consists of a display, indicator lights, and buttons you press to control the functions 
available on the printer. The control panel: 
• Displays the current operating status of the printer. 
• Provides access to print features. 
• Provides access to reports. 
• Provides access to setup menus. 
• Prompts you to load paper, replace supplies, and clear jams. 
• Displays errors and warnings. 

 
1. Information displays additional information about error or status messages on the control panel. 
2. Control panel display provides information about error or status messages. 
3. Menu displays or closes the system menu screen. 
4. Print Menu provides access to documents stored in the printer or the server, such as Secure Print. 

This feature is available when the optional RAM disk or Productivity Kit is installed. 
5. Power Saver enters or exits Energy Saver mode. The button illuminates when in Energy Saver mode. 
6. Cancel stops the current job. 
7. OK selects or executes the option or function displayed on the screen. 
8. Arrow buttons navigate to the next menu, item, or option. 
9. Back navigates up one level in the menu. 
10. HDD indicator blinks while data is being read from or written to the optional hard drive. 
11. Error indicator is on when a user-correctable error is present, such as a paper jam. It blinks when a 

system error is present, often associated with an error code. 
12. Ready indicator is on when the printer is online and off when the printer is offline or has an error 

condition. It blinks while the printer is receiving data. 
13. Online changes between the online and offline state. 
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Printer Reports 

Your printer has a printable set of reports. These include configuration and font information, 
demonstration pages, and more. 

Notes: 

• If the control panel is dark, press the Power Saver button. 
• Use the arrow buttons to navigate through the menus. 

 

Printing Reports 
1. At the control panel, press Menu. 
2. Navigate to Print Reports, then press OK. 
3. Navigate to the desired report, then press OK. 
4. To print the report, at the prompt, press OK. 
5. To return the printer to Ready, press Menu. 
 

Printing the Menu Map 
1. At the control panel, press Menu. 
2. Navigate to Print Reports, then press OK. 
3. Navigate to Menu Map, then press OK. 
4. To print the report, at the prompt, press OK. 
5. To return the printer to Ready, press Menu. 
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Energy Saver Mode 

Use Energy Saver options to conserve power, and set how long the printer remains idle before changing 
modes. Ready mode is where the printer is at full power. Low Power mode is where power to the fuser 
and other areas are turned off. Sleep mode is the lowest power state the printer can obtain without 
shutting off. 
 

Setting Up Energy Saver Modes 
1. At the control panel, press Menu. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to System Settings, then press OK. 
4. Navigate to Low Power Mode, then press OK. 
5. To turn on or off Low Power mode, use the arrow buttons to select Enabled or Disabled, press OK, 

then press Back. 
6. Navigate to Low Power Timer, then press OK. 
7. To set the delay before the printer enters Low Power mode, use the arrow buttons to set the time, 

press OK, then press Back. The range is 1–240 minutes. 
8. Navigate to Sleep Mode Timer, then press OK. 
9. To set the delay before the printer enters Sleep mode, use the arrow buttons to set the time, then 

press OK. The range is 1–240 minutes. 

Note: The Low Power Timer and Sleep Mode Timer are independent, in that both start at the same 
time. 

10. To return the printer to Ready, press Menu. 
 



Features 

 

24 Phaser 7100 Color Printer 
 User Guide 
 

Administration Features 

This section includes: 
• CentreWare Internet Services ..................................................................................................................................... 24 
• Finding the IP Address on the Control Panel ......................................................................................................... 24 
• Finding the IP Address on the Configuration Report ......................................................................................... 25 
• Billing and Usage Information ................................................................................................................................... 25 

For details, see the System Administrator Guide at www.xerox.com/office/7100docs. 
 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 
 

Accessing CentreWare Internet Services 

At your computer, open a Web browser, type the IP address of the printer in the address field, then press 
Enter or Return. 
 

Finding the IP Address on the Control Panel 
1. At the control panel, press Menu. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. Navigate to Network/Port, then press OK. 
4. Navigate to TCP/IP Settings, then Press OK. 
5. Navigate to IPv4 Settings, then press OK. 

Note: For IPv6, you can find the IP address on the Configuration Report. 

6. Navigate to IP Address, then press OK. 
7. To return the printer to Ready, press Menu. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+7100&PgName=Man&Language=English�
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Finding the IP Address on the Configuration Report 
1. At the control panel, press Menu. 
2. Navigate to Print Reports, then press OK. Use the arrow buttons to navigate through the menus. 
3. Navigate to Configuration, then press OK. 
4. To print the report, at the prompt, press OK. 
5. To return the printer to Ready, press Menu. 
 

Billing and Usage Information 

Billing and printer usage information appears on the Meter Report, Job Counter Report, Current Meter 
information screen, and Billing and Counters Status page in CentreWare Internet Services. The 
impression counts shown are used for billing. For details, see Billing and Usage Information on page 86. 
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More Information 

You can obtain more information about your printer from these sources: 
 

Resource Location 

Installation Guide Packaged with printer 

Quick Use Guide Packaged with printer 

System Administrator Guide www.xerox.com/office/7100docs  

Recommended Media List United States: www.xerox.com/paper  
Europe: www.xerox.com/europaper  

Technical support information for your printer includes 
online technical support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/7100support  

Information pages Print from the control panel menu 

Order supplies for your printer www.xerox.com/office/7100supplies  

A resource for tools and information, such as interactive 
tutorials, printing templates, helpful tips, and customized 
features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox Direct online store www.direct.xerox.com/  
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This chapter includes: 
• Installation and Setup Overview ................................................................................................................................ 28 
• Modifying General Settings ......................................................................................................................................... 32 
• Installing the Software .................................................................................................................................................. 33 
 

See also:  
Installation Guide packaged with your printer. 
System Administrator Guide at www.xerox.com/office/7100docs. 
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Installation and Setup Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Configure 
the initial settings of the printer, then install the driver software and utilities on your computer. 

You can connect to your printer directly from your computer using USB, or connect over a network using 
an Ethernet cable or wireless connection. Hardware and cabling requirements vary for the different 
connection methods. Routers, network hubs, network switches, modems, Ethernet cables, and USB cables 
are not included with your printer and must be purchased separately. Xerox recommends an Ethernet 
connection because it is typically faster than a USB connection, and it provides access to CentreWare 
Internet Services. 

For details on configuring the printer settings, see the System Administrator Guide at 
www.xerox.com/office/7100docs. 
 

Selecting a Location for the Printer 
1. Select a dust-free area with temperatures from 10–32°C (50–90°F), and relative humidity 15–85%. 
 

Note: Sudden temperature fluctuations can affect print quality. Rapid heating of a cold room can 
cause condensation inside the printer, directly interfering with image transfer. 

 

2. Place the printer on a level, solid, non-vibrating surface with adequate strength for the weight of the 
printer. The printer must be horizontal with all four feet in solid contact with the surface. To find the 
weight for your printer configuration, see Physical Specifications on page 122. Select a location with 
adequate clearance to access supplies and to provide proper ventilation. To find the clearance 
requirements for your printer, see Clearance Requirements on page 123. 

After positioning the printer, you are ready to connect it to the power source and computer or network. 
 

Selecting a Connection Method 

The printer can be connected using a USB cable, an Ethernet cable, or an optional Xerox® Wireless 
Network Adapter. The method you select depends on how your computer is connected to the network. 
 

Note: The wireless network adapter installs into the Ethernet connector, replacing the Ethernet 
cable. Ethernet and USB can be connected at the same time. 

 

A USB connection is a direct connection and is the easiest to set up. An Ethernet connection is used for 
networking. If you are using a network connection, it is important to understand how your computer is 
connected to the network. 
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Note: Hardware and cabling requirements vary for the different connection methods. Routers, 
network hubs, network switches, modems, Ethernet cables, and USB cables are not included with 
your printer and must be purchased separately. 

 

• Network: If your computer is connected to an office network or home network, use an Ethernet 
cable to connect the printer to the network. You cannot connect the printer directly to the computer. 
It must be connected through a router or hub. An Ethernet network can be used for one or more 
computers and supports many printers and systems simultaneously. Ethernet connection is typically 
faster than USB and allows you direct access to the settings of the printer using CentreWare 
Internet Services. 

• Wireless Network: For printers with the optional wireless network, you can connect the printer to 
the network through a wireless router or wireless access point. A wireless network connection 
provides the same access and services as a wired connection provides. A wireless network 
connection is typically faster than USB and allows direct access to printer settings using CentreWare 
Internet Services. 

 

Note: For details on configuring wireless network settings, see the System Administrator Guide at 
www.xerox.com/office/7100docs. 

 

• USB: If you connect the printer to one computer and do not have a network, use a USB connection. 
A USB connection offers fast data speeds, but typically not as fast as an Ethernet connection. In 
addition, a USB connection does not provide access to CentreWare Internet Services. 

 

Physically Connecting the Printer to the Network 

Use a Category 5 or better Ethernet cable to connect the printer to the network. An Ethernet network is 
used for one or more computers and supports many printers and systems simultaneously. An Ethernet 
connection provides direct access to printer settings using CentreWare Internet Services. 

To connect the printer: 
1. Connect the power cord to the printer, and plug the cord into an electrical outlet. 
2. Connect one end of a Category 5 or better Ethernet cable to the Ethernet port on the printer. 

Connect the other end of the Ethernet cable to a correctly configured network port on a hub or 
router. 

3. Turn on the printer. 
 

Note: For details on configuring wireless network settings, see the System Administrator Guide at 
www.xerox.com/office/7100docs. 
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Turning the Printer On and Off 

To operate the printer, turn on the power switch. 

 

To connect a cable or move the printer, turn off the power switch. Always turn off the printer using the 
power switch, ensuring that the HDD control panel indicator is not on or blinking. 

 
 

 CAUTIONS:  

• To prevent a printer malfunction or internal hard drive damage, ensure that the HDD 
control panel indicator is off before turning off the power switch. 

• Wait 10 seconds after the control panel goes dark before turning the power switch 
back on. 

• Do not plug or unplug the power cord while the power switch is in the On position. 
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Connecting to a Computer Using USB 

To use USB, you must have Windows XP SP1 and later, Windows Server 2003 and later, or Macintosh OS 
X version 10.5 and later. 

To connect the printer to the computer using a USB cable: 
1. Ensure that the printer is turned off. 
2. Connect the B end of a standard A/B USB 2.0 cable to the USB Port on the back of the printer. 
3. Attach the power cord and then plug in the printer and turn it on. 
4. Connect the A end of the USB cable to the USB Port on the computer. 
5. When the Windows Found New Hardware Wizard appears, cancel it. 
6. You are ready to install the print drivers. For details, see Installing the Software on page 33. 
 

Initial Printer Setup 

Make sure that the printer is set up before installing the printer software. Setup includes enabling the 
optional features and assigning an IP address for the Ethernet network connection. If the printer has not 
been previously turned on and configured, see the System Administrator Guide at 
www.xerox.com/office/7100docs. 
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Modifying General Settings 

You can modify printer settings from the control panel such as the language, date and time, and units of 
measurement. You can also enable or prevent automatic Startup page printing when the printer is 
turned on. 
 

Setting the Panel Language 
1. At the control panel, press Menu. 
2. To select the Language menu, use the arrow buttons, then press OK. 
3. To select your language, use the arrow buttons, then press OK. 
4. To return the printer to Ready, press Menu. 
 

Disabling the Configuration Report at Startup 
1. At the control panel, press Menu. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. To select the System Settings menu, press the arrow buttons, then press OK. 
4. To select the Startup Page menu, press the arrow buttons, then press OK. 
5. To select Do not print, press the arrow buttons, then press OK. 
6. To return the printer to Ready, press Menu. 
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Installing the Software 

This section includes: 
• Operating System Requirements ............................................................................................................................... 33 
• Installing Drivers and Utilities for Windows .......................................................................................................... 34 
• Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later .............................................. 34 
• Installing Drivers and Utilities for UNIX and Linux ............................................................................................. 35 
• Other Drivers ...................................................................................................................................................................... 36 

Before installing driver software, verify that the printer is plugged in, turned on, connected correctly, and 
has a valid IP address. To find the IP address, see Finding the IP Address on the Control Panel on page 
24 or Finding the IP Address on the Configuration Report on page 25. 

If the Software and Documentation disc is not available, download the latest drivers from 
www.xerox.com/office/7100drivers. 
 
 

Operating System Requirements 
• Windows XP SP1 and later, Windows Vista, Windows 7, Windows Server 2003, Windows 

Server 2008, and Windows Server 2008 R2. 
• Macintosh OS X version 10.5 and later 
• UNIX and Linux: Your printer supports connection to various UNIX platforms through the network 

interface. For details, see www.xerox.com/office/7100drivers. 
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Installing Drivers and Utilities for Windows 
1. Insert the Software and Documentation disc into the appropriate drive on your computer. The 

installer starts automatically. If the installer does not start, navigate to the drive on your computer 
and double-click Setup.exe. 

2. To accept the license agreement, click I Agree. 
3. Select your printer from the list of discovered printers, then click Install. 
4. If your printer does not appear in the list of discovered printers, click Extended Search. 
5. If the printer still does not appear in the list of discovered printers, and you know the IP address: 

a. Click the Network Printer Icon, shown as a single printer. 
b. Enter the IP Address or the DNS name for the printer. 
c. Click Search, then select your printer from the list of discovered printers. 
d. When the printer appears in the window, click to highlight it, then click Next. 

6. If the printer still does not appear in the list of discovered printers, and you do not know the IP 
address: 
a. Click Advanced Search. 
b. If you know the gateway address and subnet mask, click the top button and enter the 

addresses into the Gateway and Subnet Mask fields. 
c. If you know the IP address of another printer on the same subnet, enter the address in the IP 

Address field. 
d. Click Search, then select your printer from the list of discovered printers. 

7. When the printer appears in the window, click to highlight it, then click Next. 
8. Under Print Driver Selection, select the desired print driver, or to get the latest print driver, under 

Additional Options, select Download Files from the Internet. 
9. Click Install. 
10. When the installation completes, click Finish. 
 

Installing Drivers and Utilities for Macintosh OS X Version 10.5 and Later 

Install the Xerox® print driver to access all features of your printer. 

To install the print driver software: 
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1. Insert the Software and Documentation disc into your computer. 
2. Double-click the disc icon on your desktop to see the .dmg file for your printer. 
3. Open the .dmg file, and navigate to the appropriate installer file for your operating system. 
4. Open the installer file. 
5. Click Continue to acknowledge the warning and introductory messages. 
6. Click Continue and accept the license agreement. 
7. To accept the current installation location, click Install, or select another location for the installation 

files, then click Install. 
8. Enter your password, then click OK. 
9. Select your printer in the list of discovered printers, then click Continue. 
10. If your printer does not appear in the list of discovered printers: 

a. Click the Network Printer Icon. 
b. Type the IP address of your printer, then click Continue. 
c. Select your printer in the list of discovered printers, then click Continue. 

11. To accept the print queue message, click OK. 
12. Select or clear the Set Printer as Default and Print a Test Page check boxes. 
13. Click Continue, then click Close. 
 

Note: The printer is added automatically to the printer queue. 
 

To verify that the print driver recognizes the installed options: 
1. From the Apple menu, click System Preferences > Print & Fax or Print & Scan. 
2. Select the printer in the list, then click Options and Supplies. 
3. Click Driver, then confirm that your printer is selected. 
4. Confirm that all of the options installed on the printer appear correct. 
5. If you change settings, click Apply Changes, close the window, and quit System Preferences. 
 

Installing Drivers and Utilities for UNIX and Linux 

Xerox® Services for UNIX Systems is a two part installation process. It requires the installation of a 
Xerox® Services for UNIX Systems code package and a printer support package. The Xerox® Services for 
UNIX Systems code package must be installed before installing the printer support package. 
 

Note: You must have root or superuser privileges to perform the UNIX print driver installation on 
your computer. 

 

1. At the printer, do the following: 
a. Verify that both the TCP/IP protocol and the proper connector are enabled. 
b. On the printer control panel, do one of the following for the IP address: 

• Allow the printer to set up a DHCP address. 
• Enter the IP address manually. 
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c. Print the Configuration Report and keep it for reference. For details, see Configuration Report. 
2. At your computer, do the following: 

a. Go to www.xerox.com/office/7100drivers and select your printer model. 
b. From the Operating System menu, select UNIX, then click Go. 
c. Select the Xerox® Services for UNIX Systems package for the correct operating system. This 

package is the core package and must be installed before the printer support package. 
d. To begin downloading, click the Start button. 
e. Repeat steps a and b, then click the printer package for use with the Xerox® Services for UNIX 

Systems package that you selected earlier. The second part of the driver package is ready for 
download. 

f. To begin downloading, click the Start button. 
g. In the notes below the driver package that you selected, click the link for the Installation 

Guide, then follow the installation instructions. 
 

Notes: 

• To load Linux print drivers, perform the preceding procedures but select Linux as the 
operating system. Select Xerox® Services for Linux Systems driver or the Linux CUPS 
Printing Package. You can also use the CUPS driver included in the Linux package. 

• Supported Linux drivers are available at www.xerox.com/office/7100drivers. 
• For details about UNIX and Linux drivers, see the System Administrator Guide at 

www.xerox.com/office/7100docs. 
 
 

Other Drivers 

The following drivers are available for download at www.xerox.com/office/7100drivers. 
• The Xerox® Global Print Driver works with any printer on your network, including those printers 

made by other manufacturers. It configures itself for your individual printer upon installation. 
• The Xerox® Mobile Express Driver works with any printer available to your computer that supports 

standard PostScript. It configures itself for the printer you select every time you print. If you travel 
frequently to the same sites, you can save your favorite printers in that location and the driver saves 
your settings. 
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This chapter includes: 
• Supported Paper ............................................................................................................................................................... 38 
• Loading Paper ................................................................................................................................................................... 42 
• Printing on Special Paper .............................................................................................................................................. 49 
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Supported Paper 

This section includes: 
• Recommended Media .................................................................................................................................................... 38 
• Ordering Paper .................................................................................................................................................................. 38 
• General Paper Loading Guidelines ............................................................................................................................ 38 
• Paper That Can Damage Your Printer ...................................................................................................................... 39 
• Paper Storage Guidelines .............................................................................................................................................. 39 
• Supported Paper Types and Weights ....................................................................................................................... 39 
• Supported Standard Paper Sizes ................................................................................................................................ 40 
• Supported Paper Sizes and Weights for Automatic 2-Sided Printing........................................................... 40 
• Supported Custom Paper Sizes ................................................................................................................................... 41 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
to ensure the best print quality and to avoid jams. 

For best results, use Xerox® paper and media recommended for your printer. 
 

Recommended Media 

A list of paper and media recommended for your printer is available at: 
• www.xerox.com/paper Recommended Media List (United States) 
• www.xerox.com/europaper Recommended Media List (Europe) 
 

Ordering Paper 

To order paper, transparencies, or other media, contact your local reseller or go to 
www.xerox.com/office/7100supplies. 
 
 

General Paper Loading Guidelines 

Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes can be loaded with the long-edge or short-edge leading 
into the printer. Long-edge feed is the preferred orientation to maximize the pages printed per minute, 
and minimize supply usage. 
• Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to jam. 
• Adjust the paper guides to fit the paper size. 
• Fan paper before loading it in the paper tray. 
• If excessive jams occur, use paper or other approved media from a new package. 
• Do not print on label media once a label has been removed from a sheet. 
• Use only paper envelopes. Print envelopes 1-sided only. 
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Paper That Can Damage Your Printer 

Some paper and other media types can cause poor output quality, increased paper jams, or damage 
your printer. Do not use the following: 
• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 
 

Paper Storage Guidelines 

Storing your paper and other media properly contributes to optimum print quality. 
• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from 

ultraviolet and visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly 
damaging to paper. 

• Reduce the exposure of paper to strong lights for long periods of time. 
• Maintain constant temperatures and relative humidity. 
• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect 

moisture. 
• Store paper flat, either on pallets, cartons, shelves, or in cabinets. 
• Avoid food or drinks in the area where paper is stored or handled. 
• Do not open sealed packages of paper until you are ready to load them into the printer. Leave 

stored paper in the original packaging. The paper wrapper protects the paper from moisture loss or 
gain. 

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until 
you are ready to use it. Keep unused media in the bag and reseal it for protection. 
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Supported Paper Types and Weights 

Trays Types and Weights 

Tray 1 and Bypass Tray Plain (60–80 g/m²) 
Hole Punched (60–80 g/m²) 
Letterhead (81–105 g/m²) 
Heavyweight (81–105 g/m²) 
Cardstock (106–163 g/m²) 
Heavyweight Cardstock (164–220 g/m²) 
Pre-Printed (60–80 g/m²) 
Recycled (60–80 g/m²) 
Labels (106–169 g/m²) 

Trays 2–4 Plain (60–80 g/m²) 
Hole Punched (60–80 g/m²) 
Letterhead (81–105 g/m²) 
Heavyweight (81–105 g/m²) 
Cardstock (106–163 g/m²) 
Pre-Printed (60–80 g/m²) 
Recycled (60–80 g/m²) 
Labels (106–169 g/m²) 

Bypass Tray only Glossy (106–163 g/m²) 
Glossy Cardstock (164–220 g/m²) 
Envelope 

  
 

Supported Standard Paper Sizes 
 

Tray European Standard Sizes North American Standard Sizes 

All trays A3 (297 x 420 mm, 11.7 x 16.5 in.) 
A4 (210 x 297 mm, 8.3 x 11.7 in.) 
A5 (148 x 210 mm, 8.3 x 5.8 in.) 

Letter (216 x 279 mm, 8.5 x 11 in.) 
Legal (216 x 356 mm, 8.5 x 14 in.) 
Tabloid (279 x 432 mm, 11 x 17 in.) 
216 x 330 mm, 8.5 x 13 in. 

Bypass Tray 
only 

A6 (105 x 148 mm, 4.1 x 5.8 in.) 
DL envelope (110 x 220 mm, 
4.33 x 8.66 in.) 
C5 envelope (162 x 229 mm, 
6.4 x 9 in.) 
C6 envelope (114 x 162 mm, 
4.5 x 6.38 in.) 

Monarch envelope (98 x 190 mm, 
3.9 x 7.5 in.) 
No. 10 envelope (241 x 105 mm, 4.1 x 9.5 in.) 
Statement (140 x 216 mm, 5.5 x 8.5 in.) 
127 x 178 mm, 5 x 7 in. 
Executive (184 x 267 mm, 7.25 x 10.5 in.) 
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Supported Paper Sizes and Weights for Automatic 2-Sided Printing 
 

 Minimum Maximum 

Size 148 x 210 mm (5.8 x 8.3 in.) 297 x 432 mm (11.7 x 17 in.) 

Weight 60 g/m² 120 g/m² 
 

Note: The printer does not support 2-sided printing on labels or envelopes. 
 

Supported Custom Paper Sizes 
 

Tray Number Paper Sizes, Minimum–Maximum 

Trays 1–4 Width: 75–297 mm (3–11.7 in.) 
Length: 98–432 mm (3.9–17 in.) 

Bypass Tray Width: 75–297 mm (3–11.7 in.) 
Length: 98–432 mm (3.9–17 in.) 
Two banner page sizes are supported: 

297 x 1200 mm (11.7 x 47.3 in.) 
210 x 900 mm (8.3 x 35.5 in.) 
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Loading Paper 

This section includes: 
• Loading Paper in Trays 1–4 .......................................................................................................................................... 42 
• Loading Paper in the Bypass Tray ............................................................................................................................. 46 
• Changing Paper Size, Type, and Color ..................................................................................................................... 48 
 
 

Loading Paper in Trays 1–4 
1. Pull out the tray until it stops. 

 
2. Remove any paper that is a different size. 
3. Extend the length of the paper tray as needed. 

a. Tilt the tray upward, and pull to remove it. 
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b. To extend Tray 1 for large format paper, pinch the release tab and fully extend the rear of the 
tray. 

 

 
c. To reduce Tray 1, pinch the release tab and slide the rear of the tray back into the tray body. 
d. To extend Trays 2–4 for large format paper, slide both locking tabs out, to their unlocked 

position and fully extend the rear of the tray. 
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Note: When fully extended, the locking tabs click automatically into their locked position. 

e. To reduce Trays 2–4, slide both locking tabs out, to their unlocked position. Then slide the rear 
of the tray back into the tray body until the locking tabs click into their locked position. 

4. Adjust the length and width guides to fit the paper. 
a. Pinch the guide lever on each guide. 
b. Slide the guides to the size of the paper. 
c. To secure the guides in position, release the levers. 

 
• Adjust Tray 1 width guides. 

 
• Adjust Trays 2–4 width guides. 

 
5. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. 

This procedure separates any sheets that are stuck together and reduces the possibility of jams. 
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Note: To avoid jams and misfeeds, do not remove paper from its packaging until you are ready to 
use it. 

6. Load the paper in the tray: 
 

With Duplex Unit Without Duplex Unit 

Insert the paper long-edge feed, with the print side face 
down and the top edge to the right. Load hole punched 
paper with the holes facing the front of the tray. 

 

Insert the paper long-edge feed, with the print side face 
up and the top edge to the right. Load hole punched 
paper with the holes toward the back. 

 
Insert large-format paper short-edge feed, with the print 
side face down and the top edge facing the front of the 
tray. Load hole punched paper with the holes to the left. 

 

Insert large-format paper short-edge feed, with the print 
side face up and the top edge facing the back of the 
tray. Load hole punched paper with the holes to the left. 

 
 

Notes: 

• Do not load paper above the maximum fill line. Overfilling the tray can cause the printer to 
jam. 

• For faster print speeds, load paper long-edge feed. 
7. If previously removed, reinsert the tray into the printer. 
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8. Close the tray. 

 
Note: Paper trays extend out the rear of the printer. Ensure that the printer is not too close to the 
wall to allow the tray to be inserted fully into the printer. 

9. If no paper change settings are necessary at the control panel prompt, press Back. To change the 
size, type, and color, press OK and follow the prompts. 

 

Loading Paper in the Bypass Tray 
The Bypass Tray supports the widest variety of paper types. It is intended primarily for small 
quantity jobs using special paper. The tray extension provides support for larger paper. 

Notes: 

• For faster print speeds, load paper 320 mm (12.6 in.) or shorter long-edge feed. 
• Load paper longer than 320 mm (12.6 in.) short-edge feed. 
• Do not load paper above the maximum fill line. Overfilling can cause paper jams. 

1. Open the Bypass Tray and pull out the tray extensions for larger sizes. 
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2. Load the paper in the tray: 
 

With Duplex Unit Without Duplex Unit 

Insert the paper long-edge feed, with the print side face 
up and the top edge to the right. Load hole punched 
paper with the holes facing into the printer. 

 

Insert the paper long-edge feed, with the print side face 
down and the top edge to the right. Load hole punched 
paper with the holes facing you. 

 
Insert large-format paper short-edge feed, with the print 
side face up and the top edge facing into the printer. 
Load hole punched paper with the holes to the left. 

 

Insert large-format paper short-edge feed, with the print 
side face down and the top edge facing you. Load hole 
punched paper with the holes to the left. 

 
 

3. Adjust the width guides until they touch the edges of the paper. 

 
4. If no paper change settings are necessary at the control panel prompt, press Back. To change the 

size, type, and color, press OK and follow the prompts. 
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Changing Paper Size, Type, and Color 

When Trays 1–4 are set to Allow Change mode, you can change paper settings each time you load the 
tray. When you close the tray, the control panel prompts you to change the tray settings for paper size, 
type, and color. 

When Trays 1–4 are set to No Attribute Change mode, the prompt to change the tray settings does not 
appear. The printer uses the paper guide settings to determine the paper size, and the current control 
panel settings for the type and color of paper. 

When you load paper into the Bypass Tray, the control panel prompts you to change the tray settings. 
No Attribute Change mode does not affect Bypass Tray paper size, type, and color behavior. 

To set a tray to No Attribute Change mode: 
1. At the control panel, press Menu. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. To select Printer Settings, press the arrow buttons, then press OK. 
4. To select During Loading, press the arrow buttons, then press OK. 
5. To select No Attrib. Change, press the arrow buttons, then press OK. 
6. To return the printer to Ready, press Menu. 

To set the paper size, type, or color for a tray in No Attribute Change mode: 
1. At the control panel, press Menu. 
2. To select Admin Menu, press the arrow buttons, then press OK. 
3. To select Printer Settings, press the arrow buttons, then press OK. 
4. To select Paper Size Settings, Paper Type, or Paper Color, press the arrow buttons, then press OK. 
5. To select the option that you want to modify, press the arrow buttons, then press OK. 
6. To select the new setting, press the arrow buttons, then press OK. 
7. To return the printer to Ready, press Menu. 

Note: When Panel Lock is On, you can be required to enter a passcode to access the control panel 
menus. For details, see the System Administrator Guide at www.xerox.com/office/7100docs. 

 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=Color&Model=Phaser+7100&PgName=Man&Language=English�
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Printing on Special Paper 

This section includes: 
• Envelopes ............................................................................................................................................................................ 49 
• Labels .................................................................................................................................................................................... 51 
• Glossy Paper and Glossy Cardstock ........................................................................................................................... 54 

To order paper or other media, contact your local reseller or visit www.xerox.com/office/7100supplies. 
 

See also:  
www.xerox.com/paper Recommended Media List (United States) 
www.xerox.com/europaper Recommended Media List (Europe) 

 

 
 

Envelopes 

Print envelopes only from the Bypass Tray. For details, see Supported Standard Paper Sizes on page 40. 
 

Guidelines for Printing Envelopes 
• Print quality depends on the quality and construction of the envelopes. Try another envelope brand 

if you do not get desired results. 
• Maintain constant temperatures and relative humidity. 
• Store unused envelopes in their packaging to avoid the excess moisture and dryness which can 

affect print quality and cause wrinkling. Excessive moisture can cause the envelopes to seal before 
or during printing. 

• Remove air bubbles from the envelopes before loading them into the tray by setting a heavy book 
on top of them. 

• In the print driver software, select Envelope as the paper type. 
• Do not use padded envelopes. Use envelopes that lie flat on a surface. 
• Do not use envelopes with heat activated glue. 
• Do not use envelopes with press and seal flaps. 
• Use only paper envelopes. 
• Do not use envelopes with windows or metal clasps. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=order&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=rmlna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=rmleu&Language=English�
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Loading Envelopes in the Bypass Tray 
Note: Do not load more than 10 envelopes in the Bypass Tray. Overfilling the tray can cause the 
printer to jam. 

1. Open the Bypass Tray and pull out the tray extensions for larger sizes. 

 
2. Load envelopes with the flaps closed and facing up. 

• Load No.10, Monarch, or DL envelopes with the long edge facing into the printer. 

 
 

Note: If you do not load envelopes immediately after they have been removed from the packaging, 
they can bulge. Flatten them to avoid jams. 

 
 

 



Paper and Media 

 

 Phaser 7100 Color Printer 51 
 User Guide 
 

• Load large envelopes with the flaps open and facing up. 

 
 

 CAUTION: Never use self-stick envelopes, envelopes with exposed adhesives, or envelopes with 
windows. They can lead to paper jams and can damage the printer. 

 

3. Adjust the width guides to fit the envelopes. 

 
4. If no paper change settings are necessary at the control panel prompt, press Back. To change the 

size, type, and color, press OK and follow the prompts. 
 

Labels 

You can print labels from any tray. 
 

Guidelines for Printing Labels 
• Use labels designed for laser printing. 
• Do not use vinyl labels. 
• Do not feed a sheet of labels through the printer more than once. 
• Do not use dry gum labels. 
• Print only on one side of the sheet of labels. Use full sheet labels only. 
• Store unused labels flat in their original packaging. Leave the sheets of labels inside the original 

packaging until ready to use. Return any unused sheets of labels to the original packaging and 
reseal it. 

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing 
them in extreme conditions can cause print-quality problems or cause them to jam in the printer. 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and 
jam in the printer. 
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• In the print driver software, select Label as the paper type. 
• Remove all other paper from the tray before loading labels. 
 

 CAUTION: Do not use any sheet where labels are missing, curled, or pulled away from the backing 
sheet. It could damage the printer. 

 
 

Loading Labels in Trays 1–4 
1. Pull out the tray until it stops. 

 
2. Ensure that the paper guides are set in the correct position for the size labels you are loading. 
3. For long-edge feed, load labels face up with the top edge to the left. 

 
4. For short-edge feed, load labels face up with the top edge facing away from the printer. 

 
5. Close the tray. Set the paper size, type, and color on the control panel. For details, see Changing 

Paper Size, Type, and Color on page 48. 
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Loading Labels in the Bypass Tray 
1. Open the Bypass Tray and pull out the tray extensions for larger sizes. 

 
2. For labels 320 mm (12.6 in.) or shorter, insert the labels face down, long-edge feed, with the top 

edge to the left. 

 
3. For labels longer than 320 mm (12.6 in.), insert the labels face down, short-edge feed, with the top 

edge leading into the printer. 

 
4. Adjust the width guides until they touch the edges of the labels. 
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5. If no paper change settings are necessary at the control panel prompt, press Back. To change the 
size, type, and color, press OK and follow the prompts. 

 

Glossy Paper and Glossy Cardstock 

You can print Glossy and Glossy Cardstock from the Bypass Tray only. Load paper into the tray with the 
print side face down. 
 

Guidelines for Printing on Glossy Cardstock 
• Do not open sealed packages of glossy cardstock until you are ready to load them into the printer. 
• Leave glossy cardstock in the original wrapper, and leave the packages in the shipping carton until 

ready to use. 
• Remove all other paper from the tray before loading glossy cardstock. 
• Load only the amount of glossy cardstock you are planning to use. Do not leave glossy cardstock in 

the tray when you are finished printing. Replace unused cardstock in the original wrapper and seal. 
• Rotate stock frequently. Long periods of storage in extreme conditions can cause glossy cardstock to 

curl and jam in the printer. 
• In the print driver software, select the desired glossy cardstock type or select the tray loaded with 

the desired paper. 
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This chapter includes: 
• Printing Overview ............................................................................................................................................................. 56 
• Selecting Printing Options ............................................................................................................................................ 57 
• Printing Features .............................................................................................................................................................. 60 
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Printing Overview 

Before printing, your computer and the printer must be plugged in, turned on, and connected. Ensure 
that you have the correct print driver software installed on your computer. For details, see Installing the 
Software. 
1. Select the appropriate paper. 
2. Load paper in the appropriate tray. On the printer control panel, specify the size, color, and type. 
3. Access the print settings in your software application. For most software applications, press CTRL+P 

for Windows, or CMD+P for Macintosh. 
4. Select your printer from the list. 
5. Access the print driver settings by selecting Properties or Preferences for Windows, or Xerox® 

Features for Macintosh. The title of the button can vary depending on your application. 
6. Modify the print driver settings as necessary, then click OK. 
7. Click Print to send the job to the printer. 
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Selecting Printing Options 

This section includes: 
• Print Driver Help................................................................................................................................................................ 57 
• Windows Printing Options ............................................................................................................................................ 57 
• Macintosh Printing Options ......................................................................................................................................... 59 

Printing options, also called print driver software options, are specified as Printing Preferences in 
Windows, and Xerox® Features in Macintosh. Printing options include settings for 2-sided printing, page 
layout, and print quality. Printing options that are set from Printing Preferences become the default 
setting. Printing options that are set from within the software application are temporary. The application 
and the computer do not save the settings after the application is closed. 
 
 

Print Driver Help 

Xerox® print driver software Help information is available from the Printing Preferences window. Click the 
Help (?) button in the bottom left corner of the Printing Preferences window to see the Help. 

 

Information about Printing Preferences appears in the Help window. From there, you can select by topic 
or use the search field to enter the topic or function for which you need information. 
 

Windows Printing Options 

Setting Default Printing Options for Windows 

When you print from any software application, the printer uses the print job settings specified in the 
Printing Preferences window. You can specify your most common printing options and save them so that 
you do not have to change them every time you print. 
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For example, if you want to print on both sides of the paper for most jobs, specify 2-sided printing in 
Printing Preferences. 

To select default printing options: 
1. Navigate to the list of printers on your computer: 

• For Windows XP SP1 and later, click Start > Settings > Printers and Faxes. 
• For Windows Vista, click Start > Control Panel > Hardware and Sound > Printers. 
• For Windows Server 2003 and later, click Start > Settings > Printers. 
• For Windows 7, click Start > Devices and Printers. 

2. In the list, right-click the icon for your printer and click Printing Preferences. 
3. In the Printing Preferences window, click a tab, select the options, then click OK to save. 
  

Note: For more information about Windows print driver options, click the Help button (?) in the 
Printing Preferences window. 

 
 

Selecting Printing Options for an Individual Job for Windows 

To use special printing options for a particular job, change the Printing Preferences from the application 
before sending the job to the printer. For example, if you want to use the Enhanced print-quality mode 
when printing a particular document, select Enhanced in Printing Preferences before printing the job. 
1. With the document open in your software application, access the print settings. For most software 

applications, click File > Print or press CTRL+P for Windows. 
2. Select your printer and click the Properties or Preferences button to open the Printing Preferences 

window. The title of the button can vary depending on your application. 
3. Click a tab in the Printing Preferences window, then make selections. 
4. Click OK to save and close the Printing Preferences window. 
5. Click Print to send the job to the printer. 
 
 

Saving a Set of Commonly Used Printing Options for Windows 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select the printer, then click Properties. Click the tabs in the Printing Properties window and select 

the desired settings. 
3. Click Saved Settings at the bottom of the Printing Properties window, then click Save As. 
4. Type a name for the set of printing options, then click OK to save the set of options in the Saved 

Settings list. 
5. Select the name from the list to print using these options. 
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Macintosh Printing Options 

Selecting Printing Options for Macintosh 

To use specific printing options, change the settings before sending the job to the printer. 
1. With the document open in your application, click File > Print. 
2. Select your printer from the list. 
3. Select Xerox® Features from the Copies & Pages menu. 
4. Select the desired printing options from the drop-down lists. 
5. Click Print to send the job to the printer. 
 
 

Saving a Set of Commonly Used Printing Options for Macintosh 

You can define and save a set of options, so that you can apply them to future print jobs. 

To save a set of printing options: 
1. With the document open in your application, click File > Print. 
2. Select your printer from the Printers list. 
3. Select the desired printing options from the drop-down lists in the Print dialog box. 
4. Click Presets > Save As. 
5. Type a name for the printing options, then click OK to save the set of options in the Presets list. 
6. To print using these options, select the name from the Presets list. 
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Printing Features 

This section includes: 
• Printing on Both Sides of the Paper .......................................................................................................................... 60 
• Orientation ......................................................................................................................................................................... 61 
• Selecting Paper Options for Printing ......................................................................................................................... 62 
• Printing Multiple Pages to a Single Sheet ............................................................................................................... 62 
• Printing Booklets .............................................................................................................................................................. 62 
• Print Quality ....................................................................................................................................................................... 63 
• Image Options .................................................................................................................................................................. 63 
• Printing Covers .................................................................................................................................................................. 64 
• Printing Inserts .................................................................................................................................................................. 64 
• Printing Exception Pages ............................................................................................................................................... 64 
• Scaling .................................................................................................................................................................................. 65 
• Printing Watermarks ....................................................................................................................................................... 66 
• Printing Mirror Images ................................................................................................................................................... 66 
• Creating and Saving Custom Paper Sizes ............................................................................................................... 66 
• Selecting Job Completion Notification for Windows ......................................................................................... 67 
• Printing Special Job Types ............................................................................................................................................ 67 
 
 

Printing on Both Sides of the Paper 

Printing a 2-Sided Document 

If your printer supports Automatic 2-Sided Printing, the options are specified in the print driver. The print 
driver uses the settings for portrait or landscape orientation from the application for printing the 
document. 

Note: Ensure that the paper size and weight are supported. For details, see Supported Paper Sizes and 
Weights for Automatic 2-Sided Printing on page 40. 
 

2-Sided Page Layout Options 

You can specify the page layout for 2-sided printing, which determines how the printed pages turn. 
These settings override the application page orientation settings. 



Printing 

 

 Phaser 7100 Color Printer 61 
 User Guide 
 

To make a 2-sided printing selection, on the Page Layout tab, use the arrow button in the bottom left 
corner of the preview pane. Page Layout is on the Document Options tab. 

 
• 1-Sided Print prints on one side of the media. Use this option when printing on transparencies, 

envelopes, labels, or other media that cannot be printed on both sides. 
• 2-Sided Print prints the job on both sides of the paper to allow binding on the long edge of the 

paper. The following illustrations show the result for documents with portrait and landscape 
orientations, respectively: 

     
• 2-Sided Print, Flip on Short Edge prints on both sides of the paper. The images print to allow 

binding on the short edge of the paper. The following illustrations show the result for 
documents with portrait and landscape orientations, respectively: 

   
 

Note: 2-Sided Printing is part of the Earth Smart settings. 
 

To change your default print driver settings, see Setting Default Printing Options for Windows on page 
57. 
 

Orientation 

To select the default orientation: 
1. On the Advanced tab, click Driver. 
2. Click Orientation. Select an option: 

• Portrait orients the paper so that the text and images print across the short dimension of the 
paper. 
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• Landscape orients the paper so that the text and images print across the long dimension of 
the paper. 

 
• Rotated Landscape orients the paper so that the content is rotated 180 degrees and with the 

long bottom side up. 

 
3. Click OK. 
 

Selecting Paper Options for Printing 

There are two ways to select the paper for your print job. You can let the printer select which paper to 
use based on the document size, paper type, and paper color you specify. You can also select a specific 
tray loaded with the desired paper. 
 

Printing Multiple Pages to a Single Sheet 

When printing a multiple-page document, you can print more than one page on a single sheet of paper. 
Print 1, 2, 4, 6, 9, or 16 pages per side by selecting Pages Per Sheet on the Page Layout tab. Page Layout 
is on the Document Options tab. 

 
 

Printing Booklets 

With 2-sided printing, you can print a document in the form of a small booklet. Create booklets from any 
paper size that is supported for 2-sided printing. The driver automatically reduces each page image and 
prints four page images per sheet of paper, two page images on each side. The pages are printed in the 
correct order so that you can fold and staple the pages to create the booklet. 

When you print booklets using the Windows PostScript or Macintosh driver, you can specify the gutter 
and creep. 
• Gutter specifies the horizontal distance in points between the page images. A point is 0.35 mm 

(1/72 in.). 
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• Creep specifies how much the page images are shifted outward, in tenths of a point. Shifting 
compensates for the thickness of the folded paper, which would cause the page images to shift 
slightly outward when folded. You can select a value from zero to 1 point. 

 

Gutter Creep 

 
 

 
 
 
 
 

 
 

Print Quality 

Print quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• Enhanced print-quality mode: 1200 x 1200 dpi 
• Photo print-quality mode: 600 x 600 x 8 dpi 

Note: The print resolutions are indicated for PostScript print drivers only. The only print quality 
mode for PCL is Standard. 

 

Image Options 

Image options controls the way the printer uses color to produce your document. The Windows 
PostScript and the Macintosh drivers provide the widest range of color controls and corrections on the 
Image Options tab. 

To convert all color in the document to black and white or shades of gray, select Xerox Black and White 
Conversion. 

Color corrections designed for your printer include: 
• Automatic Color applies the best color correction to text, graphics, and images. Xerox recommends 

this setting. 
• Vivid Color produces brighter and more saturated colors. 
• sRGB provides color correction for matching the standard red, blue, and green color characteristics 

of computer displays. 
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Printing Covers 

A cover is the first or last page of a document. You can select paper sources for the covers that are 
different from the source used for the body of a document. For example, you can use your company 
letterhead for the first page of a document. You can also use heavyweight paper for the first and last 
pages of a report. You can use any applicable paper tray as the source for printing covers. 

Select an option for printing covers: 
• No Covers cancels any previous Covers settings. 
• Front Only prints the first page on paper from the specified tray. With automatic 2-sided printing, 

the first two pages print on the cover. 
• Back Only prints the back page on paper from the specified tray. With automatic 2-sided printing, 

the last two pages print on the cover when the page count is even. 
• Front and Back: Same prints the front and back covers from the same tray. 
• Front and Back: Different prints the front and back covers from different trays. 
 

Printing Inserts 

You can add blank or pre-printed inserts before page one of each document or after designated pages 
within a document. Adding an insert after designated pages within a document separates sections, or 
acts as a marker or placeholder. Make sure that you specify the paper to use for the inserts. 

Modify these settings when printing inserts: 
• Insert Options provides the options to place an insert After Page X, where X is the specified page, or 

Before Page 1. 
• Insert Quantity specifies the number of pages to insert at each location. 
• Page(s) specifies a page or a range of pages after which you want an insert added. Separate 

individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to add inserts after pages 1, 6, 9, 10, and 11, type: 1, 6, 9-11. 

• Paper displays the default size, color, and type of paper selected in Use Job Settings for the inserts. 
Use the Down Arrow to the right of the Paper field to select a different paper size, color, or type. 

• Job Settings displays the attributes of the paper for the remainder of the job. 
 

Printing Exception Pages 

Exception pages have different settings from the rest of the pages in the job. You can specify differences 
such as page size, page type, and page color. You can also change the side of the paper on which to print 
as your job requires. A print job can contain multiple exceptions. 

For example, your print job contains 30 pages. You want five pages to print on only one side of a special 
paper, and the remainder of the pages printed 2-sided on regular paper. You can use exception pages to 
print the job. 

In the Add Exceptions window, you can set the characteristics of the exception pages and select the 
alternate paper source: 
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• Page(s) specifies the page or range of pages that use the exception page characteristics. Separate 
individual pages or page ranges with commas. Specify pages within a range with a hyphen. For 
example, to specify pages 1, 6, 9, 10, and 11, type 1,6,9-11. 

• Paper displays the default size, color, and type of paper selected in Use Job Settings. Click the Down 
Arrow to the right of the Paper field to select a different paper size, color, or type. 

• 2-Sided Printing allows you to select 2-sided printing options. Click the Down Arrow to select an 
option: 
• 1-Sided Print prints the exception pages on one side only. 
• 2-Sided Print prints the exception pages on both sides of the paper and flips the pages on the 

long edge. The job then can be bound on the long edge of the pages. 
• 2-Sided Print, Flip on Short Edge prints the exception pages on both sides of the paper and 

flips the pages on the short edge. The job then can be bound on the short edge of the pages. 
• Job Settings displays the attributes of the paper for the remainder of the job. 
 

Notes: 

• If your printer does not support automatic 2-sided printing, not all of the options are 
available. 

• Some combinations of 2-sided printing with certain paper types and sizes can produce 
unexpected results. 

 
 

Scaling 

Scaling reduces or enlarges the original document to match the selected output paper size. In Windows, 
the Scale Options are located in the print driver on the Printing Options tab in the Paper field. 

To access Scale Options, click the arrow at the right side of the Paper field, then select Other Size. 
• No Scaling does not change the size of the page image printed on the output paper, and 100% 

appears in the percentage box. If the original size is larger than the output size, the page image is 
cropped. If the original size is smaller than the output size, extra space appears around the page 
image. 

• Automatically Scale scales the document to fit the selected Output Paper Size. The scaling amount 
appears in the percentage box below the sample image. 

• Manually Scale scales the document by the amount entered in the percentage box below the 
preview image. 
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Printing Watermarks 

A watermark is special purpose text that can be printed across one or more pages. For example, you can 
add a word like Copy, Draft, or Confidential as a watermark instead of stamping it on a document before 
distribution. 

 

To print a watermark: 
1. Click Document Options > Watermark. 
2. From the Watermark menu, select the watermark. 
3. Click Layering, then select how to print the watermark: 

• Print in Background prints the watermark behind the text and graphics in the document. 
• Blend combines the watermark with the text and graphics in the document. A blended 

watermark is translucent, so you can see both the watermark and the document content. 
• Print in Foreground prints the watermark over the text and graphics in the document. 

4. Click Pages, then select the pages on which to print the watermark: 
• Print on All Pages prints the watermark on all pages of your document. 
• Print on Page 1 Only prints the watermark only on the first page of the document. 

5. Click OK. 
 

Printing Mirror Images 

If the PostScript driver is installed, you can print pages as a mirror image. Images mirror left to right 
when printed. 
 

Creating and Saving Custom Paper Sizes 

You can print custom-size paper from any paper tray. Custom-size paper settings are saved in the print 
driver and are available for you to select in all your applications. 

For detail on supported paper sizes for each tray, see Supported Custom Paper Sizes on page 41. 

To create and save custom sizes for Windows: 
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1. Click the Paper/Output tab of the print driver. 
2. Click the arrow at the right of the Paper field, then select Other Size > Output Paper Size > New. 
3. In the New Custom Size window, enter the height and width of the new size, then select the units. 
4. Enter a title for the new size in the Name field, then click OK to save. 

To create and save custom sizes for Macintosh: 
1. In the application, click File > Page Setup. 
2. Click Paper Sizes, then select Manage Paper Sizes. 
3. To add a new size, in the Manage Paper Sizes window, click the plus sign (+). 
4. Double-click Untitled at the top of the window and type a name for the new custom size. 
5. Enter the height and width of the new custom size. 
6. Click the arrow to the right of the Non-Printable Area field and select the printer from the list. Or set 

the top, bottom, right, and left margins for User Defined margins. 
7. To save the settings, click OK. 
 

Selecting Job Completion Notification for Windows 

You can select to be notified when your job finishes printing. A message appears on your computer 
screen with the name of the job and the name of the printer where it was printed. 
 

Note: This feature is only available on a Windows computer printing to a network printer. 
 

To select job completion notification from the Advanced tab: 
1. Click Notification. 
2. Click Notify for Completed Jobs. Select an option: 

• Enabled turns on notifications. 
• Disabled turns off the Notification feature. 

3. Click OK. 
 

Printing Special Job Types 

Special job types allow you to send a print job from your computer, then print it from the printer control 
panel. Select special job types in the print driver, Printing Options tab, under Job Type. 

Note: To use any of the special job types, your printer must have the RAM Disk feature enabled or 
the optional Productivity Kit installed. 

 

Sample Set 

The Sample Set job type allows you to print a sample copy of a multiple-copy job and hold the 
remaining copies at the printer. After you review the sample copy, you can select the job name from the 
printer control panel to print the additional copies. 
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Notes: 

• If the control panel is dark, press the Power Saver button. 
• Use the arrow buttons to navigate through the menus. 

To release the remainder of prints after printing a Sample Set: 
1. At the control panel, touch Print Menu. 
2. Navigate to Sample Set, then press OK. 
3. Navigate to your directory under Select User ID, then press the Right arrow. 
4. Navigate to the desired print job, then press the Right arrow. 
5. Navigate to Print, then press OK. 
6. To increase or decrease the Quantity, press the arrow buttons, then press OK. 
7. To print the job, press OK. 

The remainder of the job prints, and the job is deleted from the printer. 
8. To return the printer to Ready, press Back. 
 

Secure Print 

Secure Print allows you to associate a 1–12 digit passcode number with a print job when sending it to 
the printer. The job is held at the printer until the same passcode is entered at the control panel. 

Notes: 

• If the control panel is dark, press the Power Saver button. 
• Use the arrow buttons to navigate through the menus. 

To release a Secure Print job for printing: 
1. At the control panel, touch Print Menu. 
2. Navigate to Secure Print, then press OK. 
3. Navigate to your directory under Select User ID, then press the Right arrow. 
4. Use the arrow buttons to enter your passcode, then press OK. 
5. Navigate to the desired print job, then press the Right arrow. 
6. Navigate to Print & Delete or Print & Save, then press OK. 
7. To increase or decrease the Quantity, press the arrow buttons, then press OK. 
8. To print the job, press OK. 

To return the printer to Ready, press Back. 
 

Delay Print 

You can delay a print job for up to 24 hours from the original job submission time. Enter the time at 
which you would like the job to print. If the time you enter is earlier than the time that you submit the 
print job, it prints on the following day. The Delayed Print default time is midnight. 
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Notes: 

• If the control panel is dark, press the Power Saver button. 
• Use the arrow buttons to navigate through the menus. 

To print the job after you send it but before the scheduled time, release the job at the printer control 
panel: 
1. At the control panel, touch Print Menu. 
2. Navigate to Delayed Print, then press OK. 
3. Navigate to the desired print job, then press the Right arrow. 
4. Navigate to Print Now, then press OK. 
5. To print the job, press OK. 
6. To return the printer to Ready, press Back. 
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Maintenance and Cleaning 

This section includes: 
• General Precautions ........................................................................................................................................................ 72 
• Cleaning the Printer ........................................................................................................................................................ 73 
• Routine Maintenance ..................................................................................................................................................... 80 
• Periodic Maintenance ..................................................................................................................................................... 81 
 
 

General Precautions 
 

 CAUTION: When cleaning your printer do not use organic or strong chemical solvents or aerosol 
cleaners. Do not pour fluids directly into any area. Use supplies and cleaning materials only as 
directed in this documentation. 

  

 WARNING: Keep all cleaning materials out of the reach of children. 
  

 WARNING: Do not use pressurized spray cleaning aids on or in the printer. Some pressurized sprays 
contain explosive mixtures and are not suitable for use in electrical applications. Use of such cleaners 
increase the risk of fire and explosion. 

  

 WARNING: Do not remove the covers or guards that are fastened with screws. You cannot maintain 
or service any parts that are behind these covers and guards. Do not attempt any maintenance 
procedure that is not described in the documentation supplied with your printer. 

  

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

• Do not place anything on top of the printer. 
• Do not leave the covers and doors open for any length of time, especially in well-lit places. Light 

exposure can damage the imaging units. 
• Do not open covers and doors during printing. 
• Do not tilt the printer while it is in use. 
• Do not touch the electrical contacts or gears. Doing so could damage the printer and cause the print 

quality to deteriorate. 
• Ensure any parts removed during cleaning are replaced before you plug in the printer. 
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Cleaning the Printer 

This section includes: 
• Cleaning the Printer Exterior ........................................................................................................................................ 73 
• Cleaning the Laser Lenses ............................................................................................................................................. 74 
• Cleaning the Density Sensors ...................................................................................................................................... 77 
 
 

Cleaning the Printer Exterior 

Regular cleaning keeps the control panel and its display free from dust and dirt. 

To clean the printer exterior: 
1. To avoid activating buttons and menus, ensure that the printer is in Sleep mode. If the Power Saver 

button is not illuminated, press the Power Saver button. 

 
2. To remove finger prints and smudges, clean the control panel and its display with a soft, lint-free 

cloth. 
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3. Press the Power Saver button again to return the printer to Ready mode. 
4. Use a soft, lint-free cloth to clean the outside of the output tray, paper trays, and other exterior 

areas of your printer. 

 
 

Cleaning the Laser Lenses 

The printer is constructed with four laser lenses. If prints have voids or light streaks through one or more 
colors, use the following instructions to clean the laser lenses. 
 

 CAUTIONS:  

• Ensure that nothing touches or scratches the surface of the transfer belt. Scratches, 
dirt, or oil from your hands on the belt can deteriorate print quality. 

• Ensure that nothing touches or scratches the surface of the imaging drum. Scratches, 
dirt, or oil from your hands on the drum can deteriorate print quality. 

• To protect the imaging units against bright light, close Cover C within 10 minutes. 
Longer exposure can deteriorate print quality. 

 

 WARNING: If you accidentally get toner on your clothes, lightly dust them off as best as you can. If 
some toner remains on your clothes, use cool water, not hot, to rinse off the toner. If toner gets on 
your skin, wash it off with cool water and a mild soap. If you get toner in your eyes, wash it out 
immediately with cool water and consult a doctor. 

 

1. Open Cover A. 
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2. Open Cover C. 

 
3. Support Cover C by lowering its support (1) and inserting it into its associated slot (2). 
 

 WARNING: Cover is not self-supporting. Use care to support with your hand or the built-in support. 
 

 
4. To remove the cleaning tool, lift it out of the printer. 

 
5. Remove the yellow imaging unit. 
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6. Clean the laser lens by wiping the length of its surface three times using the soft end of the cleaning 
tool. 

 
7. Replace the imaging unit. 

 
8. Repeat steps 5 through 7 for each color. 

 
9. Replace the cleaning tool. 
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10. To close Cover C, raise it slightly, then raise the support rod (1) and snap it into its holder (2). 

 
11. Close Cover C (1), the Toner Cover (2), and Cover A (3). 

 
 

Cleaning the Density Sensors 

If the print or color density is too light, missing, or the background is foggy, clean the density sensors. 
 

 CAUTIONS:  

• Ensure that nothing touches or scratches the surface of the transfer belt. Scratches, 
dirt, or oil from your hands on the belt can deteriorate print quality. 

• To protect the imaging units against bright light, close Cover C within 10 minutes. 
Longer exposure can deteriorate print quality. 

 

1. Open Cover A. 
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2. Open Cover C. 

 
3. Support Cover C by lowering its support (1) and inserting it into its associated slot (2). 
 

 WARNING: Cover is not self-supporting. Use care to support with your hand or the built-in support. 
 

 
4. Use a dry cotton swab to clean the color toner density sensors. 

 
5. To close Cover C, raise it slightly, then raise the support rod (1) and snap it into its holder (2). 
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6. Close Cover C (1), the Toner Cover (2), and Cover A (3). 
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Routine Maintenance 

For information on ordering supplies, see Ordering Supplies on page 87. 
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Periodic Maintenance 

For information on ordering supplies, see Ordering Supplies on page 87. 
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Adjustments and Maintenance Procedures 

This section includes: 
• Color Registration ............................................................................................................................................................ 82 
• Adjusting Paper Type ..................................................................................................................................................... 83 
• Adjusting the Voltage Offset ....................................................................................................................................... 84 
• Adjusting the Fuser ......................................................................................................................................................... 84 
• Adjusting the Altitude .................................................................................................................................................... 84 
• Enabling Dew Prevention .............................................................................................................................................. 85 
 
 

Color Registration 

The printer automatically adjusts the color registration when automatic adjustment is turned on. You 
can also adjust color registration manually any time the printer is idle. You must adjust the color 
registration any time the printer is moved. If you are having printing problems, adjust the color 
registration. 
 

Performing an Automatic Color Registration Adjustment 

Automatic color registration adjustment occurs every time a new toner cartridge is installed. You can run 
this adjustment at other times as needed. 

To perform an automatic color registration adjustment: 
1. At the printer control panel, press the Menu button. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to Image Quality, then press OK. 
4. Navigate to Adjust Color Regi, then press OK. 
5. Navigate to Auto Color Regi, then press OK. 
6. To begin the calibration, at the prompt, press OK. 
 

Performing a Manual Color Registration Adjustment 

Color Registration adjusts the printer to make corrections to blurry or hazy prints, or prints with color 
halos. 

To perform a manual color registration adjustment: 
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1. At the printer control panel, press the Menu button. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to Image Quality, then press OK. 
4. Navigate to Adjust Color Regi, then press OK. 
5. Navigate to Manual Color Regi, then press OK. 
6. Navigate to Color Regi Chart, then press OK. 
7. Load the default paper size, long-edge feed into the Bypass Tray. 
8. To print the color registration chart, press OK. 
9. Starting with the left side calibration lines, LY, LM, and LC, circle the line in each group where the 

color bar aligns with the adjacent black bars. 

 
10. Repeat the process for the right side calibration lines, RY, RM, and RC. 
11. To navigate to the adjustment menu, press Back. 
12. Navigate to Adjust Color Regi, then press OK. 
13. Navigate to the desired color, Adjust Yellow, Adjust Magenta, or Adjust Cyan, then press OK. 
14. To enter the values, navigate to the left or right field. Then use the arrow buttons to adjust the 

value to what you circled in steps 9 and 10, then press OK. 
15. Press Back, then repeat steps 13 and 14 for the other colors. 
16. Print another Registration Chart, then repeat the process until you complete the color registration 

corrections. 
 

Adjusting Paper Type 

Use Adjust Paper Type to compensate for paper thickness within a paper type. If the printed image is 
too light, use a heavier setting for the paper you are using. If the printed image is mottled or 
blotchy-looking, decrease the setting for the paper you are using. 

To adjust the paper type: 
1. At the printer control panel, press the Menu button. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to Printer Settings, then press OK. 
4. Navigate to Paper Type, then press OK. 
5. Navigate to the desired paper tray, then press OK. 
6. To adjust the paper type, navigate to the next heavier or thinner paper type, then press OK. 
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Adjusting the Voltage Offset 

Use Voltage Offset to specify the bias voltage for printing on the selected paper type. If the printed 
image is too light, increase the offset for the paper you are using. If the printed image is mottled or 
blotchy-looking, decrease the offset for the paper you are using. 

To adjust the voltage offset: 
1. At the printer control panel, press the Menu button. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to Image Quality, then press OK. 
4. Navigate to Voltage Offset, then press OK. 
5. Navigate to the paper type for the adjustment, then press OK. 
6. Press the arrow buttons to increase or decrease the amount of offset, then press OK. 
7. Repeat this procedure for each paper type you need to adjust. 
 

Adjusting the Fuser 

Use Adjust Fuser for optimum print quality across a wide range of paper types. If the toner on a print is 
smearing or can be rubbed off the paper, increase the offset for the paper you are using. If the toner is 
blistered or mottled, decrease the offset for the paper you are using. 

To adjust the fuser: 
1. At the printer control panel, press the Menu button. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to Image Quality, then press OK. 
4. Navigate to Fuser Temperature, then press OK. 
5. Navigate to the paper type for the adjustment, then press OK. 
6. Press the arrow buttons to increase or decrease the amount of offset, then press OK. 
7. Repeat this procedure for each paper type you need to adjust. 
 

Adjusting the Altitude 

Use Adjust Altitude to adjust the altitude to match that of the location where the printer is installed. If 
the altitude setting is incorrect, it can cause print-quality problems. 

To adjust the altitude: 
1. At the printer control panel, press the Menu button. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to Image Quality, then press OK. 
4. Navigate to Adjust Altitude, then press OK. 
5. To select the altitude of the location of the printer, press the Up or Down arrow buttons, then press 

OK. 
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Enabling Dew Prevention 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 

To enable Dew Prevention: 
1. At the printer control panel, press the Menu button. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to System Settings, then press OK. 
4. Navigate to Dew Prevention, then press OK. 
5. Select Enabled, then press OK. 
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Billing and Usage Information 

Billing and printer usage information appears on the Billing Meters information screen. The impression 
counts shown are used for billing. 
1. At the control panel, press Menu. 
2. Navigate to Meter Reading, then press OK. 
3. Navigate to Current Meter, then press OK. 
4. To view the impression counts, press the arrow buttons. 

• Total Color is the number of pages printed that specify color. 
• Total Black is the number of pages printed with no color specified. 
• Total is the total number of color impressions plus black impressions. 

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed 
on two sides counts as two impressions. 

5. To return the printer to Ready, press Menu. 
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Ordering Supplies 

This section includes: 
• Locating the Serial Number ......................................................................................................................................... 87 
• Consumables ..................................................................................................................................................................... 87 
• Routine Maintenance Items ........................................................................................................................................ 88 
• Customer Replaceable Units ........................................................................................................................................ 88 
• When to Order Supplies ................................................................................................................................................. 88 
• Viewing Printer Supply Status ..................................................................................................................................... 88 
• Recycling Supplies ............................................................................................................................................................ 89 
 
 

Locating the Serial Number 

To contact Xerox for assistance, you need the printer serial number. The serial number is on the front of 
the printer chassis under Tray 1. To view the serial number, remove Tray 1. You can also view the serial 
number on the Configuration Report. 

To print the Configuration Report: 
1. At the control panel, press Menu. 
2. Navigate to Print Reports, then press OK. 
3. Navigate to the desired report, then press OK. 
4. To print the report, at the prompt, press OK. 
5. To return the printer to Ready, press Menu. 
 

Consumables 

Consumables are printer supplies that get depleted during the operation of the printer. Consumable 
supplies for this printer are the Genuine Xerox® Toner Cartridges in Cyan, Magenta, Yellow, and Black. 
 

Notes: 

• Each consumable includes installation instructions. 
• Install only new cartridges in your printer. If a used toner cartridge is installed, then the toner 

remaining amount displayed could be inaccurate. 
• To ensure print quality, the toner cartridge has been designed to cease functioning at a 

predetermined point. 
 

 CAUTION: Use of toner other than genuine Xerox® Toner can affect print quality and printer 
reliability. Xerox® Toner is the only toner designed and manufactured under strict quality controls by 
Xerox for specific use with this printer. 
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Routine Maintenance Items 

Routine maintenance items are printer parts that have a limited life and require periodic replacement. 
Replacements can be parts or kits. Routine maintenance items are typically customer replaceable. 
 

Note: Each routine maintenance item includes installation instructions. 
 

Routine maintenance items for this printer include the following: 
• Imaging Units (Cyan, Magenta, Yellow, and Black) 
• Waste Cartridge 
 

Customer Replaceable Units 

Customer replaceable units (CRUs) are printer parts that can be replaced without need for technical 
service intervention. These parts have longer rated lives than routine maintenance items. 

Note: Each customer replaceable unit includes installation instructions. 

Customer Replaceable Units for this printer include the following: 
• 110 V Fuser 
• 220 V Fuser 
• Transfer Roller 
• Tray 1 Feed Roller Kit 
• Tray 2 Feed Roller Kit 
• Bypass Tray Feed Roller 
 

When to Order Supplies 

A warning appears on the control panel when supplies near their replacement time. Verify that you have 
replacements on hand. It is important to order these items when the messages first appear to avoid 
interruptions to your printing. An error message appears on the control panel when supplies must be 
replaced. 

Order supplies from your local reseller or go to www.xerox.com/office/7100supplies. 
 

 CAUTION: Use of non-Xerox® supplies is not recommended. The Xerox® Warranty, Service 
Agreement, and Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of 
performance caused by use of non-Xerox® supplies, or the use of Xerox® supplies not specified for this 
printer. The Total Satisfaction Guarantee is available in the United States and Canada. Coverage 
could vary outside these areas. Please contact your Xerox representative for details. 

 
 

  

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=order&Language=English�
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Viewing Printer Supply Status 

You can check the status and percentage of life remaining for your printer supplies at any time using 
CentreWare Internet Services. 
1. At your computer, open a Web browser, type the IP address of the printer in the address field, then 

press Enter or Return. 

Note: For details, see Finding the IP Address on the Control Panel on page 25. 

2. Select the Status tab. 
3. In the top-left corner of the Status page, under Status, click Consumables. 
 

Recycling Supplies 

For information on Xerox® supplies recycling programs, go to www.xerox.com/gwa. 

Supplies include a prepaid return label. Please use it to return used components in their original boxes for 
recycling. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=recyclesupplies&Language=English%20%20�
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Moving the Printer 

• Always turn off the printer and wait for the printer to shut down. 
• Disconnect the power cord from the back of the printer. 
• When lifting the printer, grasp the areas as shown. 
• Keep the printer level to avoid toner spillage. 
• Always use at least three people to lift the printer. 
 

 CAUTION: Failure to repackage the printer properly for shipment can result in damage not covered 
by the Xerox® Warranty, Service Agreement, or Total Satisfaction Guarantee. The Xerox® Warranty, 
Service Agreement, or Total Satisfaction Guarantee do not cover damage to the printer caused by 
improper moving. 

 

 
 

 CAUTION: The Xerox® Total Satisfaction Guarantee is available in the United States and Canada. 
Coverage could vary outside these areas. Please contact your Xerox representative for details. 
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This chapter includes: 
• General Troubleshooting............................................................................................................................................... 92 
• Paper Jams ......................................................................................................................................................................... 96 
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• Getting Help ..................................................................................................................................................................... 115 
 

 

 7 Troubleshooting 



Troubleshooting 

 

92 Phaser 7100 Color Printer 
 User Guide 
 

General Troubleshooting 

This section includes: 
• Printer Does Not Turn On .............................................................................................................................................. 92 
• Printer Resets or Turns Off Frequently ..................................................................................................................... 93 
• Printing Takes Too Long ................................................................................................................................................ 93 
• Document Fails to Print ................................................................................................................................................. 93 
• Document Prints from Wrong Tray ........................................................................................................................... 94 
• Automatic 2-Sided Printing Problems ...................................................................................................................... 94 
• Printer is Making Unusual Noises ............................................................................................................................... 94 
• Paper Tray Will Not Close ............................................................................................................................................. 95 
• Date and Time are Incorrect ....................................................................................................................................... 95 
• Condensation has Formed Inside the Printer ........................................................................................................ 95 

This section contains procedures to help you locate and resolve problems. Resolve some problems by 
simply restarting the printer. 
 
 

Printer Does Not Turn On 
 

Probable Causes Solutions 

The power switch is not turned on. Turn on the switch. 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer power switch, and plug the power cord securely 
into the outlet. 

Something is wrong with the outlet 
connected to the printer. 

• Plug another electrical appliance into the outlet and see if it 
operates properly. 

• Try a different outlet. 

The printer is connected to an outlet with a 
voltage or frequency that does not match the 
printer specifications. 

Use a power source with the specifications listed in the Electrical 
Specifications on page 126. 

 

 CAUTION: Plug the three-wire cord with grounding prong directly into a grounded AC outlet. 
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Printer Resets or Turns Off Frequently 
 

Probable Causes Solutions 

The power cord is not correctly plugged into 
the outlet. 

Turn off the printer, confirm that the power cord is correctly plugged 
into the printer and the outlet, then turn on the printer. 

A system error occurred. Contact your Xerox® service representative with the error code and 
message. Check the control panel fault history. For details, see 
Viewing Error Messages on the Control Panel on page 116. 

  
 

Printing Takes Too Long 
 

Probable Causes Solutions 

The printer is set to a slower printing mode, 
for example, for printing on glossy or 
heavyweight paper. 

It takes more time to print on certain types of special media. Make 
sure that the paper type is set properly in the driver and at the 
printer control panel. For details, see Print Speed on page 127. 

The printer is in Energy Saver mode. Wait. It takes time for printing to start when the printer is coming 
out of Energy Saver mode. 

The way the printer was installed on the 
network could be an issue. 

Determine if a print spooler or a computer sharing the printer is 
buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. To test the speed of the printer, 
print some information pages such as the Office Demo Page. If the 
page does not print at the rated speed of the printer, you could 
have a network or printer installation issue. 

The job is complex. Wait. No action needed. 

The print-quality mode in the driver is set to 
Enhanced. 

Change the print-quality mode in the print driver to Standard. 

The printer quality is set to Photo and the 
printer is being used for complex, 2-sided 
print jobs. 

Increase memory size to 2 GB RAM. 

 
 

Document Fails to Print 
 

Probable Causes Solutions 

Selected tray has wrong paper size loaded. 1. Check the control panel for a warning message. 
2. Check the tray selected in the print driver. 

Selected paper type or color is not available. Ensure that the paper type is set correctly in the driver and the 
paper is loaded in the correct tray. 

Control panel is in use or the printer is offline. Ensure that the printer is not offline and the control panel is not in a 
menu. If displaying Offline, press Online. If displaying a menu, press 
Menu to exit. 
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The way the printer was installed on the 
network could be an issue. 

• Ensure that the printer is connected to the network. 
• Determine if a print spooler or a computer sharing the printer is 

buffering all print jobs and then spooling them to the printer. 
Spooling can slow print speeds. 

• To test the printer, print some information pages such as the 
Demo Page. If the page prints, you could have a network or 
printer installation issue. For additional help, contact the system 
administrator. 

Application and print driver have conflicting 
tray selections. 

For details, see Document Prints from Wrong Tray on page 94. 

  
 

Document Prints from Wrong Tray 
 

Probable Causes Solutions 

Application and print driver have conflicting 
tray selections. 

1. Check the tray selected in the print driver. 
2. Go to the page setup or printer settings of the application from 

which you are printing. 
3. Set the paper source to match the tray selected in the print 

driver or set the paper source to Automatically Select. 

  
 

Automatic 2-Sided Printing Problems 
 

Probable Causes Solutions 

Unsupported or incorrect paper. Ensure that you are using a supported paper size and weight for 2-sided 
printing. Envelopes and labels cannot be used for 2-sided printing. For 
details, see Supported Paper Sizes and Weights for Automatic 2-Sided 
Printing on page 40. 

The printer does not support automatic 
2-sided printing. 

Ensure that your printer supports automatic 2-sided printing. For details, 
see Printer Configurations and Options on page 120. 

Incorrect setting. In the print driver Properties, on the Printing Options tab, select 2-sided 
Printing. 

 
 

Printer is Making Unusual Noises 
 

Probable Causes Solutions 

One of the trays is not installed correctly. Open and close the tray from which you are printing. 

There is an obstruction or debris inside the 
printer. 

Turn off the printer and remove the obstruction or debris. If you 
cannot remove it, contact your Xerox® service representative. 
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Paper Tray Will Not Close 
 

Probable Causes Solutions 

The paper tray does not fully close. Paper trays extend out the rear of the printer. Ensure that the 
printer is not too close to the wall to allow the tray to be inserted 
fully into the printer. 

 
 

Date and Time are Incorrect 

The date and time are set automatically when the printer is connected to a network that has a Network 
Time Protocol (NTP) server. NTP is used to synchronize the internal clocks of computers over a network 
connection at system startup and every subsequent 24-hour period thereafter. This feature ensures that 
the internal clock of the printer stays synchronized with the NTP server you specify. 
 

Probable Causes Solutions 

The Date and Time Setup is set to Manual (NTP 
Disabled). 

Change the Date and Time to Automatic by enabling 
NTP. For details, see the System Administrator Guide at 
www.xerox.com/office/7100docs. 

The time zone, date, or time is set incorrectly. Set the time zone, date, and time manually. For details, 
see the System Administrator Guide at 
www.xerox.com/office/7100docs. 

 
 

Condensation has Formed Inside the Printer 

Moisture can condense inside a printer where the humidity is above 85% or when a cold printer is 
located in a warm room. Condensation can form in a printer after it has been sitting in a cold room that 
is heated quickly. 
 

Probable Causes Solutions 

The printer has been sitting in a cold room. • Allow the printer to operate for several hours at room 
temperature. 

• If condensation is forming inside the printer, enable Dew 
Prevention. For details, see Enabling Dew Prevention on page 85. 

The relative humidity of the room is too high. • Reduce the humidity in the room. 
• Move the printer to a location where the temperature and 

relative humidity are within the operating specifications. 
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Paper Jams 

This section includes: 
• Clearing Paper Jams........................................................................................................................................................ 97 
• Minimizing Paper Jams ................................................................................................................................................ 105 
• Troubleshooting Paper Jams ..................................................................................................................................... 107 
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Clearing Paper Jams 

This section includes: 
• Clearing Jams at Trays 1–4 .......................................................................................................................................... 97 
• Clearing Jams at the Bypass Tray .............................................................................................................................. 99 
• Clearing Jams at Cover A ............................................................................................................................................ 100 
• Clearing Jams at Cover B ............................................................................................................................................ 101 
• Clearing Jams at the Fuser ......................................................................................................................................... 102 

To avoid damage, always remove jammed paper carefully without tearing it. Try to remove the paper in 
the same direction it normally moves through the printer. Even a small piece of paper left in the printer 
can cause a jam. Do not reload paper that has jammed. 
 
 

Clearing Jams at Trays 1–4 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
1. Check each tray to ensure that no paper remains in the paper path which passes through the front 

of each tray. 

 
2. Open Tray 1. 
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3. Tilt the tray upward, and pull to remove it. 

 
4. Remove any crumpled paper from the tray. 

 
5. Remove any remaining pieces of paper. 

 
6. Reinsert the tray into the printer. 
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7. Close the tray. 

 
Note: Paper trays extend out the rear of the printer. Ensure that the printer is not too close to the 
wall to allow the tray to be inserted fully into the printer. 

 

Clearing Jams at the Bypass Tray 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
 

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

1. Remove any paper from the bypass tray. 

 
2. Lift the Cover A Release Latch and open the cover. 
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3. If paper is visible, remove the jammed paper by pulling in the direction shown. 

 
4. Close the cover. 

 
5. Replace the paper in the tray. 
 

Note: Do not load paper above the maximum fill line. Overfilling can cause paper jams. 
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Clearing Jams at Cover A 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
 

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

1. Lift the Cover A Release Latch and open the cover. 

 
2. Lower both green fuser levers and remove the paper by pulling it in the direction shown. 

 
Note: When Cover A is closed, both fuser levers automatically return to their original position. 

3. Close the cover. 
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Clearing Jams at Cover B 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
 

 WARNING: Internal parts of the printer can be hot. Use caution when doors and covers are open. 
 

1. Press the Cover B Release Button and open the cover. 

 
2. Lift both green fuser levers to their full-upright position, then remove the paper by pulling it in the 

direction shown. 

 
Note: When Cover B is closed, both fuser levers automatically return to their original position. 

3. Close the cover. 
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Clearing Jams at the Fuser 

To resolve the error displayed on the control panel you must clear all paper from the paper path. 
 

 WARNING: To avoid burns, do not clear paper jams immediately after printing. The fuser becomes 
hot during use. 

 

1. Press the Cover B Release Button and open the cover. 

 
2. To open the fuser cover, pull its tab forward. 

 
3. To open the fuser rollers, lift both green fuser levers to their full-upright position. 
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4. To open Cover E, pull the tab forward and hold it open. 

 
5. Remove the jammed paper. 

 
6. Release Cover E. 

 
7. Lower the levers to their original position. 
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8. Close the fuser cover. 

 
9. Close Cover B. 

 
 

Minimizing Paper Jams 

The printer is designed to function with minimal paper jams using Xerox® supported paper. Other paper 
types can cause jams. If supported paper is jamming frequently in one area, clean that area of the paper 
path. 

The following can cause paper jams: 
• Selecting the incorrect paper type in the print driver. 
• Using damaged paper. 
• Using unsupported paper. 
• Loading paper incorrectly. 
• Overfilling the tray. 
• Adjusting the paper guides improperly. 

Most jams can be prevented by following a simple set of rules: 
• Use only supported paper. For details, see Supported Paper on page 38. 
• Follow proper paper handling and loading techniques. 
• Always use clean, undamaged paper. 
• Avoid paper that is curled, torn, moist, creased, or folded. 
• To separate the sheets before loading into the tray, fan the paper. 
• Observe the paper tray fill line; never overfill the tray. 
• Adjust the paper guides in all trays after inserting the paper. A guide that is not properly adjusted 

can cause poor print quality, misfeeds, skewed prints, and printer damage. 



Troubleshooting 

 

106 Phaser 7100 Color Printer 
 User Guide 
 

• After loading the trays, select the correct paper type and size on the control panel. 
• When printing, select the correct type and size in the print driver. 
• Store paper in a dry location. 
• Do not open sealed packages of paper until you are ready to load them into the printer. 
• Leave stored paper in the original packaging. The paper wrapper protects the paper from moisture 

loss or gain. 

Avoid the following: 
• Polyester coated paper that is specially designed for inkjet printers. 
• Paper that is folded, wrinkled, or excessively curled. 
• Loading more than one type, size, or weight of paper in a tray at the same time. 
• Overfilling the trays. 
• Allowing the output tray to overfill. 

For a detailed list of supported paper, go to www.xerox.com/paper. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=rmlna&Language=English�


Troubleshooting 

 

 Phaser 7100 Color Printer 107 
 User Guide 
 

Troubleshooting Paper Jams 

This section includes: 
• Multiple Sheets Pulled Together .............................................................................................................................. 107 
• Paper Misfeeds ................................................................................................................................................................ 107 
• Label and Envelope Misfeeds .................................................................................................................................... 108 
• Paper Jam Message Stays On ................................................................................................................................... 108 
• Jams During Automatic 2-Sided Printing .............................................................................................................. 108 
 
 

Multiple Sheets Pulled Together 
 

Probable Causes Solutions 

The paper tray is too full. Remove some of the paper. Do not load paper past fill line. 

The edges of the paper are not even. Remove the paper, align the edges, and then reload it. 

The paper is moist from humidity. Remove the paper from the tray, and replace it with new dry paper. 

Too much static electricity is present. • Try a new ream of paper. 
• Do not fan transparencies before loading in tray. 

Using unsupported paper. Use only Xerox®-approved paper. For details, see Supported Paper 
on page 38. 

Humidity is too high for coated paper. Feed paper one sheet at a time. 
  
 

Paper Misfeeds 
 

Probable Causes Solutions 

The paper is not correctly positioned in the 
tray. 

• Remove the misfed paper and reposition it properly in the tray. 
• Adjust the paper guides in the tray to match the size of the 

paper. 

The paper tray is too full. Remove some of the paper. Do not load paper past the fill line. 

The paper guides are not correctly adjusted 
to the paper size. 

Adjust the paper guides in the tray to match the size of the paper. 

The tray contains warped or wrinkled paper. Remove the paper, smooth it out, and reload it. If it still misfeeds, 
do not use that paper. 

The paper is moist from humidity. Remove the moist paper and replace it with new, dry paper. 

Using paper of the wrong size, thickness, or 
type. 

Use only Xerox® approved paper. For details, see Supported Paper 
on page 38. 
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Label and Envelope Misfeeds 
 

Probable Causes Solutions 

The label sheet is facing the wrong way in the 
tray. 

Load label sheets according to the instructions from the 
manufacturer. Load labels face down in the Bypass Tray and face 
up in all other trays. 

Labels are missing, curled, or pulled away 
from the backing sheet. 

Do not use any sheet where labels are missing, curled, or pulled 
away from the backing sheet. 

Envelopes are loaded incorrectly. • Load envelopes in the Bypass Tray only, with the print side down, 
flaps closed and facing up, and the long edge leading into the 
printer. 

Note: When you load envelopes long-edge feed, ensure that you 
specify landscape orientation in the print driver. 

• Load large-size envelopes with the print side down, flaps open 
and facing away from the printer. 

Envelopes are wrinkling. • The heat and pressure of the laser printing process can cause 
wrinkling. 

• Use supported envelopes. For details, see Guidelines for Printing 
Envelopes on page 49. 

 
 

Paper Jam Message Stays On 
 

Probable Causes Solutions 

Some paper remains jammed in the printer. Recheck the media path and make sure that you have removed all 
of the jammed paper. 

One of the printer doors is open. Check the doors on the printer. Close any door that is open. 
  

Note: Check for, and remove, torn pieces of paper in the paper path. 
 
 

Jams During Automatic 2-Sided Printing 
 

Probable Causes Solutions 

Using paper of the wrong size, thickness, or 
type. 

Ensure that you are using the correct paper. For details, see 
Supported Paper Sizes and Weights for Automatic 2-Sided Printing 
on page 40. 

Paper is loaded in the wrong tray. The paper must be loaded in the correct tray. For details, see 
Supported Paper on page 38. 

Tray is loaded with mixed paper. Load the tray with only one type and size of paper. 
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Print-Quality Problems 

This section includes: 
• Controlling Print Quality .............................................................................................................................................. 109 
• Solving Print-Quality Problems .................................................................................................................................. 110 

Your printer is designed to produce consistently high-quality prints. If you observe print-quality problems, 
use the information in this section to troubleshoot the problem. For more information, go to 
www.xerox.com/office/7100support. 
 

 CAUTION: The Xerox® Warranty, Service Agreement, or Xerox® Total Satisfaction Guarantee does 
not cover damage caused by using unsupported paper or specialty media. The Xerox® Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside 
these areas. Please contact your local representative for details. 

 

Notes: 

• To ensure consistent print quality, the toner cartridges and imaging units for many models of 
equipment are designed to cease functioning at a predetermined point. 

• Grayscale images printed with the composite black setting increment the color pages counter, 
because color consumables are used. Composite black is the default setting on most printers. 

 

 
 

Controlling Print Quality 

Various factors can affect the quality of the output of your printer. For consistent and optimum print 
quality, use paper designed for your printer and set the paper type correctly. Adjust the bias transfer 
roller and fuser for the paper type and weight you are using. Follow the guidelines in this section to 
maintain optimum print quality from your printer. 

Temperature and humidity affect the quality of the printed output. For optimal print quality, operate 
within the specified ranges. For details, see Environmental Specifications on page 125. 
 

Paper and Media 

Your printer is designed to use various paper and other media types. Follow the guidelines in this section 
for the best print quality and to avoid jams: 
• Use only Xerox® approved paper. For details, see Supported Paper on page 38. 
• Use only dry, undamaged paper. 
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 CAUTION: Some paper and other media types can cause poor output quality, increased paper jams, 
or damage your printer. Do not use the following: 

• Rough or porous paper 
• Inkjet paper 
• Non-laser glossy or coated paper 
• Paper that has been photocopied 
• Paper that has been folded or wrinkled 
• Paper with cutouts or perforations 
• Stapled paper 
• Envelopes with windows, metal clasps, side seams, or adhesives with release strips 
• Padded envelopes 
• Plastic media 
• Transparencies 

  

• Ensure the paper type selected in your print driver matches the paper type on which you are 
printing. 

• If you have the same size paper loaded in more than one tray, ensure that the proper tray is 
selected in the print driver. 

• Store your paper and other media properly for optimum print quality. For details, see Paper Storage 
Guidelines on page 39. 

 

Print-Quality Modes 

Select the correct print-quality setting for your print job from the print driver. For instructions on setting 
the print quality, see Selecting Printing Options on page 57. To control the print quality: 
• Ensure that the print quality is set to the correct mode. For example, if the image does not appear 

as vivid and sharp as you expect, set the print quality to Photo. The default setting is Standard. 
• Use the print-quality settings in the print driver to control print quality. If the print quality is not 

suitable, adjust the print-quality setting to an higher level. 
• Use only Xerox® approved paper. For details, see Supported Paper on page 38. 
 

Solving Print-Quality Problems 

Use the following table to find solutions to print-quality problems. 
 

Print-Quality Problems and Solutions 

When the print quality is poor, select the closest symptom from the following table and see the 
corresponding solution to correct the problem. You can also print a Demo Page to more precisely 
determine the print-quality problem. For details, see Using the Integrated Troubleshooting Tools on 
page 116. 

If the print quality does not improve after carrying out the appropriate action, contact your Xerox 
representative. 
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Problem Solution 

Smears, Smudges, and Streaks 
Dark or light marks appear on your 
output. 

 

Run several blank pages through the printer to remove toner 
accumulated on the fuser. 
If the problem persists, print a Calibration Chart to determine which 
component is causing the image-quality problem. To print the 
Calibration Chart, on the control panel, select Menu > Admin Menu > 
Image Quality > Adjust Gradation > Photo > Calibration Chart. Then 
follow the onscreen instructions. 
• If the defect occurs in one color only, replace the corresponding 

imaging unit. 
• If the defect occurs in all colors and is visible on the test page, 

replace the fuser. 

Stray black dots or white areas 
(dropouts). 

 

1. Replace the paper with a recommended size and type, and confirm 
that your control panel and print driver settings are correct. For 
details, see Supported Paper on page 38. 

2. Verify that the toner cartridges meet specifications and replace them 
if necessary. For details, see Consumables on page 87. 

Repeating Spots or Lines 
Spot or lines appear at regular intervals 
on the prints. 

 

To determine the cause, print full pages of the primary colors: cyan, 
magenta, yellow, and black (CMYK). Then measure the distance between 
the print defects. 
• Imaging Unit 94 mm (3.7 in.), 38 mm (1.5 in.), or 31 mm (1.2 in.) 
• Fuser 94 mm (3.7 in.), 83 mm (3.3 in.), or 44 mm (1.7 in.) 
• Transfer Roller 68 mm (2.7 in.) 
If the repeating defects match one of these distances, replace that item. 
For more information, and printable CMYK pages, go to 
www.xerox.com/office/7100support. 
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Faded printouts with multiple colors 
faded. 

 

1. Verify that the toner cartridges meet specifications, and replace 
them if necessary. 

2. Replace the paper with a recommended size and type, and confirm 
that your control panel and print driver settings are correct. For 
details, see Supported Paper on page 38. 

3. Adjust the paper type settings. For details, see Adjusting Paper Type 
on page 83. 

4. Adjust the bias voltage offset for the affected paper type. For details, 
see Adjusting the Voltage Offset on page 84. 

5. Adjust the altitude setting of the printer. For details, see Adjusting 
the Altitude on page 84. 

6. If moist, remove the paper from the tray, and replace it with new dry 
paper. 

7. Condensation inside the printer causes partial blanks or creased 
paper. 

• Turn on the printer and leave it on for at least one hour to get rid of 
the condensation. 

• Enable Dew Prevention. From the control panel, select Menu > 
Admin Menu > System Settings > Dew Prevention > Enabled, then 
press OK. 

 

Colors Too Light or Too Dark 
The print or color density is too light, 
missing, or the background is foggy. 

 

1. Verify that the paper you are using is the correct type for the printer 
and is loaded properly.  

2. Verify that the paper loaded in the tray matches the paper type 
selected at the control panel and in the print driver. 

3. Print the Demo Page. For details, see Printing Reports on page 22. 
If the Demo Page looks correct, the printer is printing properly. Your 
application or incorrect settings in the print driver are probably 
causing the print-quality problems. 

4. If the Demo Page did not print correctly, open and close Cover A to 
cause the printer to perform an automatic color calibration. 

5. Perform the Clean Color Density Sensor procedure. For details, see 
Cleaning the Density Sensors on page 77. 

Color around the edge of printing is 
incorrect. 
Colors are blurry or there is white area 
around objects. 

Adjust the color registration. For details, see Color Registration on page 
82. 



Troubleshooting 

 

 Phaser 7100 Color Printer 113 
 User Guide 
 

Page Margins Are Inconsistent 
The image is not centered on the page or 
the margins are not consistent. 

 

Use the paper registration adjustment to center the printed image on 
the paper. An adjustment is available for each paper tray, for 1-sided or 
2-sided prints. For more information, go to 
www.xerox.com/office/7100support. 

 

Sides 1 and 2 Are Not Aligned 
The image is not centered on the page or 
the margins are not consistent. 

 

1. To check alignment, hold your print up to a strong light and look for 
the shadow cast by Side 2. 

2. Use the paper registration adjustment to center the printed image 
on the paper. For more information, go to 
www.xerox.com/office/7100support. 

 

Vertical White Lines or Streaks - One 
Color 
Lines or streaks appear in one color of 
your output. 

 

1. Print the test pages to identify the affected color. 
• To print the Demo Page, on the control panel, select Menu > Print 

Reports > Demo Page, then press OK. 
• To print the Calibration Chart, on the control panel, select Menu > 

Admin Menu > Image Quality > Adjust Gradation > Photo > 
Calibration Chart. Then follow the onscreen instructions. 

1. Use the laser window Cleaning Tool to clean the laser window of the 
affected color. For details, see Cleaning the Laser Lenses on page 74. 

2. Check the condition of the toner cartridge and replace it if necessary. 
For more information, and printable CMYK pages, go to 
www.xerox.com/office/7100support. 
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Toner Missing or Easy to Rub Off 
Toner appears to be missing from the 
print or is easy to rub off. 

 

1. Verify that the paper you are using is the correct type for the printer 
and is loaded properly. For details, see Supported Paper Types and 
Weights on page 39. 

2. At the control panel, select a heavier paper. For details, see 
Supported Paper Types and Weights on page 39. 

3. Adjust the fuser. For details, see Adjusting the Fuser on page 84. 
4. If condensation is forming inside the printer, enable Dew Prevention. 

For details, see Enabling Dew Prevention on page 85. 

 

Blotchy or mottled images. 

 

1. Compensate for the paper thickness. For details, see Adjusting Paper 
Type on page 83. 

2. Adjust the bias voltage offset for the affected paper type. For details, 
see Adjusting the Voltage Offset on page 84. 

3. Adjust the fuser. For details, see Adjusting the Fuser on page 84. 
4. Adjust the altitude setting of the printer. For details, see Adjusting 

the Altitude on page 84. 
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Getting Help 

This section includes: 
• Control Panel Messages .............................................................................................................................................. 115 
• Using the Integrated Troubleshooting Tools ...................................................................................................... 116 
• CentreWare Internet Services ................................................................................................................................... 117 
• More Information .......................................................................................................................................................... 117 

Xerox provides several automatic diagnostic utilities to help you maintain productivity and print quality. 
 
 

Control Panel Messages 

The printer control panel provides information and troubleshooting help. When a fault or warning 
condition occurs, the control panel displays a message informing you of the problem. For many status 
and warning messages, the control panel Information provides additional information. 
 

Control Panel Help 

Information button allows you to view additional information about error or status messages on the 
control panel. The Information button is labeled with the letter i. For details, see Control Panel on page 
20. 
 

Error and Status Messages 

The printer control panel provides information and troubleshooting help. When an error or warning 
condition occurs, the control panel informs you of the problem. Error messages warn you about printer 
conditions, such as low supplies or doors open, that require your attention. 
 

Viewing Warning Messages on the Control Panel 

When a warning condition occurs, a message appears on the control panel to inform you of the problem. 
Warning messages inform you about printer conditions, such as low supplies or open doors, that require 
your attention. If more than one warning condition occurs, only one is displayed on the control panel. 
Press the Information button to view additional information about error or status messages on the 
control panel. 
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Viewing Current Faults on the Control Panel 

When a fault condition occurs, a message appears on the control panel to inform you of the problem. 
Fault messages warn you about printer conditions that prevent the printer from printing or degrade 
printing performance. If more than one fault occurs, only one is displayed on the control panel. Press the 
Information button to view additional information about error or status messages on the control panel. 
For more information, go to www.xerox.com/office/7100support. 
 

Viewing Billing and Usage Information 
1. At the control panel, press Menu. 
2. Navigate to Meter Reading, then press OK. 
3. Navigate to Current Meter, then press OK. 
4. To view the impression counts, press the arrow buttons. 

• Total Color is the number of pages printed that specify color. 
• Total Black is the number of pages printed with no color specified. 
• Total is the total number of color impressions plus black impressions. 

Note: A page is one side of a sheet of paper that can be printed on one or two sides. A sheet printed 
on two sides counts as two impressions. 

5. To return the printer to Ready, press Menu. 
 

Using the Integrated Troubleshooting Tools 

Your printer has a printable set of reports. Two of them, the Demo Page and the Error History report, can 
help with troubleshooting certain problems. The Demo Page prints an image using many colors to show 
the current ability of the printer to print. The Error History report prints information on the most recent 
printer errors. 
 

Printing Reports 
1. At the control panel, press Menu. 
2. Navigate to Print Reports, then press OK. 
3. Navigate to the desired report, then press OK. 
4. To print the report, at the prompt, press OK. 
5. To return the printer to Ready, press Menu. 
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Specifying the Source Tray for Printing Reports 
1. At the control panel, press Menu. 
2. Navigate to Admin Menu, then press OK. 
3. Navigate to Printer Settings, then press OK. 
4. Navigate to Paper Tray Priority, then press OK. 
5. Navigate to the desired paper tray, then press OK. 
6. To set the paper tray to the highest priority, navigate to Priority 1, then press OK. 

Notes: 

• To print a report, the selected paper tray must match the default paper size, type and 
color. 

• The Bypass Tray cannot be set to Priority 1. 
• To print a report from the Bypass Tray, remove Trays 1–4. Then load the default paper 

size, type, and color in the Bypass Tray. 
7. To return the printer to Ready, press Menu. 
 

CentreWare Internet Services 

CentreWare Internet Services is the administration and configuration software installed on the 
embedded Web server in the printer. It allows you to configure and administer the printer from a Web 
browser. 

CentreWare Internet Services requires: 
• A TCP/IP connection between the printer and the network in Windows, Macintosh, UNIX, or Linux 

environments. 
• TCP/IP and HTTP enabled in the printer. 
• A network-connected computer with a Web browser that supports JavaScript. 

For details, see the Help in CentreWare Internet Services or the System Administrator Guide. 

To access CentreWare Internet Services: 

At your computer, open a Web browser, type the IP address of the printer in the address field, then press 
Enter or Return. 

If you do not know the IP address of your printer, see Finding the IP Address of Your Printer on page 24. 

To access CentreWare Internet Services from Job Tracker: 

From the Job Tracker Menu, click Help, then select CentreWare Internet Services. 
 

More Information 

You can obtain more information about your printer from these sources: 
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Resource Location 

Installation Guide Packaged with printer 

Quick Use Guide Packaged with printer 

System Administrator Guide www.xerox.com/office/7100docs  

Video Tutorials Available on the printer control panel and at 
www.xerox.com/office/7100docs  

Recommended Media List United States: www.xerox.com/paper  
Europe: www.xerox.com/europaper  

Technical support information for your printer includes 
online Technical Support, Online Support Assistant, and 
driver downloads. 

www.xerox.com/office/7100support  

Information about menus or error messages Control panel Help (?) button 

Information pages Print from the control panel menu 

Order supplies for your printer www.xerox.com/office/7100supplies  

A resource for tools and information, such as interactive 
tutorials, printing templates, helpful tips, and customized 
features to meet your individual needs. 

www.xerox.com/office/businessresourcecenter  

Local sales and support center www.xerox.com/office/worldcontacts  

Printer registration www.xerox.com/office/register  

Xerox® Direct online store www.direct.xerox.com/  
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http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=reg&Language=English�
http://www.direct.xerox.com/�


 

 Phaser 7100 Color Printer 119 
 User Guide 
 

This appendix includes: 
• Printer Configurations and Options ........................................................................................................................ 120 
• Physical Specifications ................................................................................................................................................. 122 
• Environmental Specifications .................................................................................................................................... 125 
• Electrical Specifications ............................................................................................................................................... 126 
• Performance Specifications ....................................................................................................................................... 126 
 
 

 A Specifications 



Specifications 

 

120 Phaser 7100 Color Printer 
 User Guide 
 

Printer Configurations and Options 

Standard Features 

The Phaser 7100 Color Printer provides the following features: 
• Maximum print resolution 1200 x 1200 dpi 
• Print document sizes from 75 x 98 mm (3.0 x 3.9 in.) to 297 x 432 mm (11.7 x 17 in.) 
• Two sizes of banner pages are supported, 297 x 1200 mm (11.7 x 47.3 in.) and 210 x 900 mm (8.3 

x 35.5 in.) 
• Tray 1 with 250-sheet adjustable paper tray 
• 150-sheet Bypass Tray 
• 1 GB RAM 
• Universal Serial Bus (USB 2.0) 
• Ethernet 10/100 Base-T 
• True Adobe PS3, PCL 6, and XPS 
• PostScript and PCL fonts 
• Data Security 
• CentreWare Internet Services 
• CentreWare Web 
• Remote driver installation 
• WebJet Admin Interface 
• Tivoli 
• LPR, Port 9100, SMB, IPP, IPPS, and WSD printing protocols 
• SMTP, RARP, auto IP, IPv4, IPv6, SNMPv1/v2/v3, IPsec, 802.1X, WSD, Bonjour, SMB, DNS, WINS, 

DHCP, BOOTP, HTTP, HTTPS, and SLP networking protocols 
• Email Alerts 
• Automated Supplies Replenishment 
• Proactive Supplies Management 
 

Available Configurations 
 

Features by Printer Configuration 

Feature 7100N 7100DN 

Automatic 2-sided printing No Yes 
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Options and Upgrades 
• Productivity Kit with hard drive enables Job Overwrite, Secure Print, Saved Print, collation, secure 

watermarks, firmware downloads using CentreWare Internet Services and storing fonts, forms, and 
macros 

• 1 GB additional memory 
• RAM Disk enables Secure Print, Saved Print, and RAM collation 
• 550-Sheet Feeder with one universal adjustable tray 
• Stand, adjustable to 220 mm (8.7 in.) or 295 mm (11.6 in.) height 
• Duplex Unit enables automatic 2-sided printing 
• WNA-100 Wireless Network Adapter 
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Physical Specifications 

Standard Configuration 

 
 

Configuration with Duplex Unit and Three Optional 550-Sheet Feeders 
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Clearance Requirements 

Standard Configuration 
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Configuration with Three Optional 550-Sheet Feeders 
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Environmental Specifications 

Operating Temperature 
• 15–32°C 
• 59–90°F 
 

Relative Humidity 

Operating: 15–80% (non-condensing) 
 

Elevation 

For optimum performance, use the printer at elevations below 3100 m (10,170 ft.). 
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Electrical Specifications 

Power Supply Voltage and Frequency 
 

Power Supply Voltage Power Supply Frequency 

110–127 VAC +/-10%, (99–140 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

220–240 VAC +/-10%, (198–264 VAC) 50 Hz +/- 3 Hz 
60 Hz +/- 3 Hz 

 
 

Power Consumption 
 

Printing Ready Low Power (Standby) Energy Saver Sleep 

Less than 600 W Less than 70 W Less than 50 W Less than 1 W 
 
 

ENERGY STAR Qualified Product 
 
 
 
 

 

The Phaser 7100 Color Printer is ENERGY STAR® qualified under the ENERGY STAR 
Program Requirements for Imaging Equipment. 

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks. 

The ENERGY STAR Imaging Equipment Program is a team effort between United 
States, European Union, and Japanese governments and the office equipment industry 
to promote energy-efficient copiers, printers, fax, multifunction printers, personal 
computers, and monitors. Reducing product energy consumption helps combat smog, 
acid rain, and long-term changes to the climate by decreasing the emissions that result 
from generating electricity. 

Xerox® ENERGY STAR equipment is preset at the factory to switch to Energy Saver Modes after 10 
minutes from the last copy or print. 
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Performance Specifications 

Print Quality 

Print quality modes: 
• Standard print-quality mode: 600 x 600 dpi 
• Enhanced print-quality mode: 1200 x 1200 dpi 
• Photo print-quality mode: 600 x 600 x 8 dpi 

Note: The print resolutions are indicated for PostScript print drivers only. The only print quality 
mode for PCL is Standard. 

 

Print Speed 

Print speeds for continuous printing are up to 30 ppm. Print speeds are the same for color or black and 
white printing. 

Several factors affect print speed: 
• Print mode. The fastest print mode is Standard, followed by Photo, then Enhanced at half speed. 
• Paper orientation. For faster print speeds, load paper long-edge feed. Loading paper short-edge 

feed reduces print speeds. 
• Paper size. Letter (8.5 x 11 in.) and A4 (210 x 297 mm) sizes share the fastest print speed. Larger 

sizes reduce print speeds. 
• Paper weight. Lightweight prints faster than heavier paper, such as Cardstock and Labels. 
• Paper type. Plain prints faster than Glossy. 

The maximum print speed for 1-sided printing is 30 ppm on Plain, Letter/A4 paper, oriented long-edge 
feed. 

The maximum print speed for 2-sided printing is 22 ppm on Plain, Letter/A4 paper, oriented long-edge 
feed. 

The slowest print speeds are 5 ppm for 2-sided printing on Glossy, and 2-sided printing on paper loaded 
short-edge feed, which includes these sizes: 
• Legal (216 x 356 mm, 8.5 x 14 in.) 
• Tabloid (279 x 432 mm, 11 x 17 in.) 
• B4 (250 x 353 mm, 9.9 x 13.9 in.) 
• A3 (297 x 420 mm, 11.7 x 16.5 in.) 
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Basic Regulations 

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are 
designed to mitigate interference caused or received by this printer in a typical office environment. 
 

United States FCC Regulations 

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy. If it is not installed and used in accordance 
with these instructions, it may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his/her own expense. 

If this equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures: 
• Reorient or relocate the receiving antenna. 
• Increase the separation between the equipment and receiver. 
• Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected. 
• Consult the dealer or an experienced radio/TV technician for help. 

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to 
operate this equipment. 
 

Note: To ensure compliance with Part 15 of the FCC rules, use shielded interface cables. 
 
 

Canada 

This Class A digital apparatus complies with Canadian ICES-003. 

Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada. 
 

European Union 
 

 CAUTION: This is a Class A product. In a domestic environment, this product can cause radio 
interference in which case the user could be required to take adequate measures. 

 

The CE mark applied to this product symbolizes a declaration of conformity by Xerox with 
the following applicable Directives of the European Union as of the dates indicated: 
• December 12, 2006: Low Voltage Directive 2006/95/EC 
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• December 15, 2004: Electromagnetic Compatibility Directive 2004/108/EC 

This printer, if used properly in accordance with the instructions, is not dangerous for the consumer or for 
the environment. 

To ensure compliance with European Union regulations, use shielded interface cables. 

A signed copy of the Declaration of Conformity for this printer can be obtained from Xerox. 
 

European Union Lot 4 Imaging Equipment Agreement Environmental 
Information 

Environmental Information Providing Environmental Solutions and Reducing Cost 

Introduction 

The following information has been developed to assist users and has been issued in relation to the 
European Union (EU) Energy Related Products Directive, specifically the Lot 4 study on Imaging 
Equipment. This requires manufacturers to improve environmental performance of in scope products 
and supports the EU action plan on energy efficiency. 

In scope products are Household and Office equipment that meet the following criteria. 
• Standard monochrome format products with a maximum speed less than 66 A4 images per minute 
• Standard color format products with a maximum speed less than 51 A4 images per minute 
 

Environmental Benefits of Duplex Printing 

Most Xerox® products have duplex printing, also known as 2-sided printing, capability. This enables you 
to print on both sides of the paper automatically, and therefore helps to reduce the use of valuable 
resources by reducing your paper consumption. The Lot 4 Imaging Equipment agreement requires that 
on models greater than or equal to 40 ppm color or greater than or equal to 45 ppm monochrome the 
duplex function has been auto enabled, during the setup and driver installation. Some Xerox® models 
below these speed bands may also be enabled with 2-sided printing settings defaulted on at the time of 
install. Continuing to use the duplex function will reduce the environmental impact of your work. 
However, should you require simplex/1-sided printing, you may change the print settings in the print 
driver. 
 

Paper Types 

This product can be used to print on both recycled and virgin paper, approved to an environmental 
stewardship scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper 
(60 g/m²), which contains less raw material and thus save resources per print, may be used in certain 
applications. We encourage you to check if this is suitable for your printing needs. 
 

ENERGY STAR 

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of energy 
efficient models, which help to reduce environmental impact. Details on the ENERGY STAR program and 
models qualified to ENERGY STAR can be found at the following website: 
www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ  

http://www.energystar.gov/index.cfm?fuseaction=find_a_product.showProductGroup&pgw_code=IEQ�
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Power Consumption and Activation Time 

The amount of electricity a product consumes depends on the way the device is used. This product is 
designed and configured to enable you to reduce your electricity costs. After the last print it switches to 
Ready Mode. In this mode it can print again immediately if required. If the product is not used for a 
period of time, the device switches to a Power Saver Mode. In these modes, only essential functions 
remain active in order to enable reduced product power consumption. 

Upon exiting from Power Saver Mode, the first print will take slightly longer than in Ready Mode. This 
delay is the result of the system "waking up" from Power Saver mode and is typical of most imaging 
products on the market. 

If you wish to set a longer Activation Time or would like to completely deactivate the Power Save Mode, 
please consider that this device may then only switch to a lower energy level after a longer period of 
time or not at all. 

To learn more about Xerox participation in sustainability initiatives, please visit our website at: 
www.xerox.com/about-xerox/environment/enus.html  
 

Germany 

Blendschutz 

Das Gerät ist nicht für die Benutzung im unmittelbaren Gesichtsfeld am Bildschirmarbeitsplatz 
vorgesehen. Um störende Reflexionen am Bildschirmarbeitsplatz zu vermeiden, darf dieses Produkt nicht 
im unmittelbaren Gesichtsfeld platziert werden. 
 

Lärmemission 

Maschinenlärminformations-Verordnung 3. GPSGV: Der höchste Schalldruckpegel beträgt 70 dB(A) oder 
weniger gemäß EN ISO 7779. 
 

Importeur 
Xerox GmbH 
Hellersbergstraße 2-4 
41460 Neuss 
Deutschland 

 

Turkey RoHS Regulation 

In compliance with Article 7 (d), we hereby certify “it is in compliance with the EEE regulation.” 

“EEE yönetmeliğine uygundur.” 
 

http://www.xerox.com/about-xerox/environment/enus.html�
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Material Safety Data Sheets 

For Material Safety Data information regarding your printer, go to: 
• North America: www.xerox.com/msds  
• European Union: www.xerox.com/environment_europe  

For the Customer Support Center phone numbers, go to www.xerox.com/office/worldcontacts. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=msdsna&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=environmenteu&Language=English�
http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=customersupport&Language=English�
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All Countries 

If you are managing the disposal of your Xerox® product, please note that the printer may contain lead, 
mercury, perchlorate, and other materials whose disposal may be regulated due to environmental 
considerations. The presence of these materials is fully consistent with global regulations applicable at 
the time that the product was placed on the market. For recycling and disposal information, contact your 
local authorities. Perchlorate Material: This product may contain one or more Perchlorate-containing 
devices, such as batteries. Special handling may apply, please see 
www.dtsc.ca.gov/hazardouswaste/perchlorate. 
 

http://www.dtsc.ca.gov/hazardouswaste/perchlorate�
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North America 

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative 
(1-800-ASK-XEROX) to determine if this Xerox® product is part of the program. For more information 
about Xerox® environmental programs, visit www.xerox.com/environment , or for recycling and disposal 
information, contact your local authorities. 
 

http://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&Model=Phaser+7100&PgName=environmentna&Language=English�
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European Union 

Some equipment may be used in both a domestic/household and a professional/business application. 
 

Domestic/Household Environment 

 

Application of this symbol on your equipment is confirmation that you 
should not dispose of the equipment in the normal household waste 
stream. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be segregated from household waste. 

Private households within EU member states may return used electrical and electronic equipment to 
designated collection facilities free of charge. Please contact your local disposal authority for 
information. 

In some member states, when you purchase new equipment, your local retailer may be required to take 
back your old equipment free of charge. Please ask your retailer for information. 
 

Professional/Business Environment 

 

Application of this symbol on your equipment is confirmation that you 
must dispose of this equipment in compliance with agreed national 
procedures. 

In accordance with European legislation, end of life electrical and electronic equipment subject to 
disposal must be managed within agreed procedures. 

Prior to disposal, please contact your local reseller or Xerox representative for end of life take-back 
information. 
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Collection and Disposal of Equipment and Batteries 

 

These symbols on the products and/or accompanying documents 
mean that used electrical and electronic products and batteries should 
not be mixed with general household waste. 

For proper treatment, recovery, and recycling of old products and used 
batteries, please take them to applicable collection points, in 
accordance with your national legislation and the Directive 
2002/96/EC and 2006/66/EC. 

By disposing of these products and batteries correctly, you will help to 
save valuable resources and prevent any potential negative effects on 
human health and the environment which could otherwise arise from 
inappropriate waste handling. 

For more information about collection and recycling of old products 
and batteries, please contact your local municipality, your waste 
disposal service or the point of sale where you purchased the items.  

Penalties may be applicable for incorrect disposal of this waste, in 
accordance with national legislation. 

 
 

Business Users in the European Union 

If you wish to discard electrical and electronic equipment, please contact your dealer or supplier for 
further information. 
 

Disposal Outside of the European Union 

These symbols are only valid in the European Union. If you wish to discard these items, please contact 
your local authorities or dealer and ask for the correct method of disposal. 
 

Battery Symbol Note 

Hg  

This wheeled bin symbol may be used in combination with a chemical 
symbol. This establishes compliance with the requirements set out by 
the Directive. 

 
 

Battery Removal 

Batteries should only be replaced by a MANUFACTURER-approved service facility. 
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Other Countries 

Please contact your local waste management authority to request disposal guidance. 
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